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About the GEM (Graphically Enhanced Manuals) 










Most titles are available in three different formats: 


     pdf downloads from my website www.DingDingMusic.com/Manuals ...........


  multi-touch iBooks on Apple’s iBooks Store .............
   printed books on Amazon.com  ....


(some manuals are also available in Deutsch, Español, 简体中文) 


For a list of all the available titles and bundles: www.DingDingMusic.com/Manuals 
To be notified about new releases and updates, subscribe to subscribe@DingDingMusic.com 


About the Formatting 


I use a specific color code in my books: 
I indicate Keyboard Shortcuts with these individual green buttons    and use the following 
abbreviations: sh (shift key), ctr (control key), opt (option key), cmd (command key).  
I indicate click actions with these blue buttons , , ,  that can be combined with 
modifier keys, for example,    . 
Brown colored text indicates Menu Commands with a greater sign (➤) indicating submenus.  
Edit ➤ Source Media ➤ All means "Click on the Edit Menu, scroll down to Source Media, and select the 
submenu All". 
Dimmed Blue text indicates an important term 
Condensed text indicates a command or a label. 
Blue arrows indicate what happens if you click or right-click on an item or popup menu  


UNDERSTAND, not just LEARN 


What are Graphically Enhanced Manuals? They're a new type of manual with a visual approach 
that helps you UNDERSTAND a program, not just LEARN it. No need to read through 500 pages 
of dry text explanations. Rich graphics and diagrams help you to get that "aha" effect and make it 
easy to comprehend difficult concepts. The Graphically Enhanced Manuals help you master a 
program much faster with a much deeper understanding of concepts, features, and workflows in 
a very intuitive way that is easy to understand.


Upcoming 
Releases



http://www.DingDingMusic.com/Manuals

http://www.DingDingMusic.com/Manuals

http://www.amazon.com/Edgar-Rothermich/e/B005I6AUVA/ref=ntt_dp_epwbk_0

http://www.DingDingMusic.com/Manuals

mailto:subscribe@DingDingMusic.com
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 1 - Introduction 


   About This Book    


The Spring of  2020 


Zoom is a remote conferencing service that combines video conferencing, online meetings, chat, and mobile 
collaboration. It was founded 2011 by Eric Yuan, a former lead engineer from Cisco System working at their 
WebEx unit. 
Zoom gained success over the years and is widely used by businesses and schools. 
Like many other universities, at Loyola Marymount University where I teach audio 
production classes, all faculties and students have free access to use Zoom in their 
classrooms or for their studies. I used it in my winter semester class 2019/2020 for the 
topic "Remote Podcast Recording". Then, in February/March 2020 the world changed 
due to COVID-19 and virtually all educational institutions (and businesses) had to 
change their classes to "socially-distant online meetings" mainly using Zoom. 


Everybody tried to get up to speed and learn Zoom, convert their classes into virtual 
classrooms and struggled to figure out how Zoom worked. 


Why did I write this book? 


Along with IT support at universities and companies, there are countless YouTube videos demonstrating how 
to use Zoom. However they all lack two important things that encouraged me to write this book. 


Illustrate Concepts for Better Understanding 


Most YouTube videos only cover the basics on how to use Zoom but don't explain the underlying concepts. 
This  creates a problem that many users have their system up and running very quickly, but often struggle 
with the details or unexpected "surprises". In this book I will provide more detailed explanations of the main 
concepts with diagrams and graphics so the users (hosts and participants) can really understand and utilize 
the power of Zoom with their great features. 


Advanced Audio Integration 


Converting a class into an online class that relies on audio applications and DAWs like Pro Tools or Logic Pro 
X is quite challenging. The good news is that Zoom is powerful enough to use it for such a purpose (with 
some workaround). Unfortunately, there is no information available on how to do that. So I did a lot of testing 
and experimenting so I can present those solutions in this book: 


I will show signal flow diagrams and graphics to demonstrate what is going on "under the hood" so 
users with an understanding of computer audio and audio signal flow will better understand the 
functionality of the various buttons and checkboxes in Zoom. 
I will show solutions and workarounds to overcome restrictions in Zoom when using Pro Tools and 
Logic Pro X.  
I will also show how to use your iPhone camera as a live cam during the meeting to demonstrate 
hardware components (mixer, microphones, etc.) in an online class session or collaboration. 
All the demonstrations regarding audio in this book are based on macOS. That's what I use. Hopefully 
Windows and Linux users can interpolate those concepts and key commands to their OS.  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   The GEM Advantage    


If you’ve never read any of my other books and you aren’t familiar with my Graphically Enhanced Manuals 
(GEM) series, let me explain my approach. As I mentioned at the beginning, my motto is: 


"UNDERSTAND, not just LEARN" 
 


Other manuals (original User Guides or third party books) often provide just a quick 
way to: "press here and then click there, then that will happen ... now click over there, 
and something else will happen". This will go on for the next couple hundred pages, 
and all you’ll do is memorize lots of steps without understanding the reason for doing 
them in the first place. Even more problematic is that you are stuck when you try to 
perform a procedure and the promised outcome doesn't happen. You will have no 
understanding why it didn't happen and, most importantly, what to do to make it 


happen. 
Don't get me wrong, I’ll also explain all the necessary procedures, but beyond that, the understanding of the 
underlying concept so you’ll know the reason why you have to click here or there. Teaching you "why" 
develops a much deeper understanding of the application that later enables you, based on your knowledge, 
to react to "unexpected" situations. In the end, you will master the application. 
And how do I provide that understanding? The key element is the visual approach, presenting easy to 
understand diagrams that describe an underlying concept better than five pages of text-only descriptions.  
I mark important terms in this manual with a gray font. Try to memorize those terms or descriptions because 
that is the language you are using to communicate with other fellow Logic users or when asking questions or 
engaging in discussions on various Logic forums. 


 


GEM
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Here is a summary of the advantages of my Graphically Enhanced Manuals that set them apart from other 
books: 


Better Learning 


Graphics, Graphics, Graphics 
Every feature and concept is explained with rich graphics and illustrations that are not found in any other 
book or User Guide, let alone YouTube videos. These are not just a few screenshots with arrows in it. I take 
the time to create unique diagrams to illustrate the concepts and workflows. 


Knowledge and Understanding 
The purpose of my manuals is to provide the reader with the knowledge and understanding of an app 
that is much more valuable than just listing and explaining a set of features. 


Comprehensive 
For any given feature, I list every available command so you can decide which one to use in your workflow. 
Some of the information is not even found in the app's User Guide. 


For Beginners and Advanced Users 
The graphical approach makes my manuals easy to understand for beginners, but still, the wealth of 
information and details provide plenty of material, even for the most advanced user. 


 


Better Value 


Three formats 
No other manual is available in all three formats: PDF (from my website), interactive multi-touch iBooks (on 
Apple's iBooks Store), and printed book (on Amazon). 


Interactive iBooks 
No other manual is available in the enhanced iBooks format. I include an extensive glossary, also with 
additional graphics. Every term throughout the content of the iBook is linked to the glossary term that lets 
you pop up a little window with the explanations without leaving the page you are currently reading. Every 
term lists all the entries in the book where it is used and links to other related terms. 


?


$
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Self-published 


As a self-published author, I can release my books without any restrictions imposed by a publisher. Rich, full-
color graphics and interactive books are usually too expensive to produce for such a limited audience. 
However, I have read mountains of manuals throughout the 35 years of my professional career as a musician, 
composer, sound engineer, and teacher, and I am developing these Graphically Enhanced Manuals (GEM) 
based on that experience, the way I think a manual should be written. This is, as you can imagine, very time 
consuming and requires a lot of dedication. 


However, not having a big publisher also means not having a big advertising budget and the connections to 
get my books into the available channels of libraries, bookstores, and schools. Instead, as a self-published 
author, I rely on reviews, blogs, referrals, and word of mouth to continue this series. 
If you like my "Graphically Enhanced Manuals", you can help me promote these books by referring them to 
others and maybe taking a minute to write a review on Amazon or the iBooks Store.   
Thanks, I appreciate it: 


   http://amzn.to/1sP8jvl        http://bit.ly/1oJ7ftQ 


Disclaimer: As a non-native English speaker, I try my best to write my manuals with proper grammar and 
spelling. However, not having a major publisher also means that I don't have a big staff of editors and 
proofreaders at my disposal. So, if something slips through and it really bothers you, email me at 
<GrammarPolice@DingDingMusic.com>, and I will fix it in the next update. Thanks! 


LogicProGEM 


Please check out my Logic site "LogicProGEM.com". The link 
"Blog" contains all the free Logic Articles that I have published 
on the web and continue to publish. These are in-depth tutorials 
that use the same concept of rich graphics to cover specific 
topics related to Logic Pro X. 


 


Music Tech Explained - the visual approach 


As additional educational material, I provide free instructional videos on my YouTube channel  
"Music Tech Explained - the visual approach". 
These are high-quality videos in 4K about topics for Logic Pro X, Pro Tools, and general audio production 
workflow tips. 


Don't forget to subscribe. 



http://amzn.to/1sP8jvl

https://itunes.apple.com/us/artist/edgar-rothermich/id253420202?uo=4&at=10l9kq

mailto:grammarpolice@DingDingMusic.com

http://LogicProGEM.com

https://YouTUbe.com/c/MusicTechExplained/
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 2 - Zoom Basics 


   Free or $$$   


Basic information about Zoom: 
Participant: To participate in a Zoom Meeting you don't need an account, only the dedicated URL 
(web address), the Meeting ID, or just a phone number to join a specific meeting. 
Host: To host a meeting, you have to sign up for an account, choosing one of the available plans: 


Free: The Basic plan allows unlimited numbers of meetings, no time limit for 1-on-1 meetings 
and a 40 min limits on meeting with up to 100 participants (just log in again after 40 min). 
Paid: There are three paid plans, Pro, Business, Enterprise, that range from $14.99/mo/host to 
$19.99/month/host that provide additional features and up to 1,000 participants per meeting. 
"Paid for": If you are part of a company or school that has a paid account, then you might host 
meetings under that licensed account and have access to those features (ask your IT 
department). 


Sign up Procedure for the FREE Basic Plan 


Step 1 - Initiate the Sign up: Go to the zoom.us website and click the blue SIGN UP button ➊ in the 
upper right corner. 
Step 2 - Request Activation via email: On the next page provide your email address so Zoom can 
send you the activation link. 
Step 3 - Create Account: Once you receive that email with the Activate Account button,  on it and it 
opens a website where you create your account by entering your First Name, Last Name, and 
Password. 


Zoom is a Video Conferencing Service


➊



http://zoom.us
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   Overview   


Basics 


Although the Zoom interface and procedures are fairly simple to jump on it very quickly, there are a lot of 
details and concepts that are not so obvious. I try to point those out on the next few pages. 


Two Components 


The first, and most important, aspect about the Zoom video conferencing service is that it has two main 
components:  


The Zoom Website (http://zoom.us), also referred to as the Zoom Web Portal 
The Zoom Application (zoom.us), also referred to as the Zoom Client 


Based on this fundamental understanding, here are the main rules: 
Create an Account: A Zoom Account can only be created on the Zoom Website ➊ 
Host/Join a Meeting: A Zoom Meeting can only take place on the Zoom Application ➋. There is the 
option in the settings for the host to join in using the website instead. 
Cross-platform: The Zoom Application is cross-platform ➌, available on most computer and 
cellphone operating systems. You can even join a meeting via a phone call (audio only). 
Two Types of Settings: The settings that configure your Zoom Meeting are spread across both 
components. Settings are available on the Zoom Website ➊ and on the Zoom Application ➋. 
Sign In: Although you don't have to be signed in to your account on the Zoom Application, you 
should if you are hosting a meeting, because some settings during a meeting are only active when 
you are signed in. 


Zoom Account 


Here are a few rules about your Zoom Account: 
You do not need a Zoom Account to join a Zoom Meeting. 
You need to create a Zoom account (free or paid) to host a Zoom Meeting. 
Attention: If you want to host a meeting and initiate it on the Zoom Application, then you have to be 
signed-in to your Zoom Account on the app first. However, if you initiate such a meeting from the 
Zoom Website (which launches the Zoom Application in the process), you could host the meeting on 
the Zoom Application without being signed in. Although possible, it is not a good idea because some 
settings are not active (i.e. stereo sound). 


I show the details about the (confusing) sign-in procedures a little later. 


Zoom Website Zoom Application
http://zoom.us zoom.us


Web Portal Zoom Client


macOS 
Windows 
Linux 
iOS 
Android 
(phone call)


➋


➌➊
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Concepts and Terminology 


Here are a couple of important terminology with an explanation of the basic concept of a Zoom Meeting. 


Host  


A Zoom Meeting always has to be created by a 
Host ➊, someone with a Zoom Account. 


Participants 


Everybody participating in (joining in) a meeting is 
referred to as a Participant ➊. Technically, the host 
is also a participant. 


Meeting 


A Zoom Meeting is like a virtual  
conference room ➌.  
It requires a host to create a Zoom Meeting, the same way a host would arrange a physical conference room 
for everybody to meet in the "real world". 


Create a Meeting: To host a meeting in the physical world you would reserve a specific room where 
the meeting takes place. With the virtual meeting in Zoom that is the first step where the host create a 
Zoom Meeting. 
Meeting ID: If you set up a physical meeting in your company, you would dedicate a specific room 
(i.e. 4th floor room 420) for the meeting to take place. When you (as the host) set up a Zoom Meeting, 
the Zoom Server ➍ assigns a unique Meeting ID ➎ that corresponds to that specific Zoom Meeting. 
Invitation: Once you have set up the Zoom Meeting and have the corresponding Meeting ID, you can 
send the invitation to the participants that you want (allow) in that meeting.  


Meeting URL: The invitation could be a specific URL (web address) that Zoom provides. Most 
users know how to click on a link, so it is super easy to join by clicking on the guided links.  
Meeting ID: You could also give experienced participants just the Meeting ID if the know how to 
join in with that. 
Phone Number: Zoom also provides a dedicated phone number for participants to join in (voice 
only) to a specific Zoom Meeting. 


Personal Meeting ID (PMI): When you originally create a Zoom account, you will be assigned your 
own Personal Meeting ID (or it will be assigned to you by IT in a corporation). This is like your virtual 
office room number. When you start a new Zoom Meeting, you can use that Personal Meeting ID as 
the Meeting ID. It is like telling your participants "Let's meet in my office". If you have a corporate 
account you might be able to change your Personal Meeting ID to your (easy to remember) phone 
number (it is in your Profile Settings on the Web Portal). 
Participants: In the real world, "participating" in a meeting means to step into the meeting room. With 
Zoom it means to open the Zoom Application, entering the Meeting ID so it opens the Meeting 
Window. Now you are in the meeting. 
Meeting Window: In the real world, everybody who steps into a meeting room (joins the meeting), 
participates in that meeting. With the virtual meeting in Zoom, everybody who opens the Meeting 
Window in their Zoom Application with a specific Meeting ID "steps" into that virtual meeting and is a 
participant until they leave that virtual room by closing their Meeting Window. 
Password: You can attach a Meeting Password to a meeting so only participants who knows the 
password can join the meeting. 
Zoom Server: The Zoom Meeting "takes place" on the Zoom Servers ➍. That means the traffic (your 
connection to the meeting) is routed via the internet to those central servers. All connections are 
encrypted (AES256). Using a phone line lets you participate as "call in participant". 
Record Meetings: Zoom provides the option that the host can record the meeting on her or his 
computer or remotely on the Zoom Server and make that file available to Participants later. 


Host


Participant


Participant


Participant


Participant


Participant


Participant


Zoom Meeting (Virtual Meeting Room)


Meeting ID


Zoom Server


➊


➋


➌


➍


➎
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Zoom Website (Web Portal) 


Let's get into the more specifics and start with the first of two components, the Zoom Website. When you 
open your web browser and sign in to the www.zoom.us website with your account, you are using the Zoom 
Web Portal. 


Interface 


The interface has three areas: 
Top (upper-right) ➊: There are 
three text links (SCHEDULE A MEETING ➋, 
JOIN A MEETING ➌, and HOST A MEETING 
➍, plus your profile picture ➎ to click 
on for information about your 
account. 
Side ➏: The sidebar list various links 
grouped under PERSONAL ➐ and 
ADMIN ➑ to configure your account 
and your activities. 
Center ➒: The center of the screen 
displays the information and settings 
depending on what link on top or 
the side you clicked on. 


Tasks 


These are the tasks that you can perform on the Web Portal: 
Manage your Account: The usual parameters. 
Manage your Meetings: Setup new meetings ➋, 
access recorded meetings, etc. 
Host and Join a Meeting: Start joining ➌ a meeting 
or start hosting ➍ a meeting. Attention: This will 
switch to the Zoom Application because the actual 
meeting is not conducted on the web browser, it is 
conducted via the zoom.us application. 
Manage your Settings: Zoom provides a huge 
amount of settings that let you configure your Zoom 
Meetings and every aspect of it. Attention: Once you 
open the Zoom.us application and sign in to your 
Zoom Account, you will have additional settings to 
configure. So keep in mind, settings are configured 
on two levels! 


➊


➒


Zoom Website


I'm signed in


➋ ➌ ➍ ➎


➏


➐


➑



http://zoom.us
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Zoom.us Application (Zoom Client) 


Launch Zoom Application 


Now let's look at the second component, the Zoom Application zoom.us ➊ installed on your computer. What 
happens when you launch the zoom.us application on your computer depends on your sign-in status. 


Not Signed In 


If you launch the app the first time or haven't 
enabled the Keep me signed in ➋ checkbox when you 
signed in previously, then the Zoom Application will 
open displaying the Start Window ➌ with two 
options.  


If you  the Join a Meeting ➍ button, you 
don't need a Zoom Account to sign in and 
can just join a Zoom Meeting. 
If you  the Sign In ➎ button, you open 
the Sign In Window ➏ that opens the Zoom 
Window when you enter the correct 
account credentials.  


Automatically Signed In 


If you have used the Zoom application before and 
enabled the Keep me signed in ➋ checkbox in the Sign 
In Window ➏, then the Zoom Application will open 
with the Zoom Window ➑, automatically signed in 
with your previous account credentials. 


 


The procedure is similar when you 
launch the Zoom app on your iPhone, 
showing your Start Window ➒ or the 
Zoom Window ➓ depending on your 
sign-in status. 


Start Window Zoom Window


Zoom iPhone app


➒ ➓


Zoom WindowStart Window


Launch Zoom


not signed in automatically signed in


➊


➌


➍


➎


➏ ➐


➑


➋
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Three Main Windows 


The Zoom Application has three main windows that you have to 
be aware of:  


Start Window 


The Start Window ➊ is the first window that pops up when you 
launch the Zoom app (without being automatically signed in). 


 


Zoom Window 


The Zoom Window ➋ is the main window that opens when you 
sign in to your Zoom Account. Be careful, you can close that 
window by clicking on the red close button in the upper-left 
corner, but there is no command (that I could find) that opens 
the Zoom Window again. However, it can be opened indirectly 
with other commands, for example,   and then . 


Meeting Window 


The Meeting Window ➌ is where you conduct your meeting 
(stepping into a virtual meeting room). It is the same window 
whether you host a meeting or just join a meeting. 
What is displayed on that window depends on your status: 


Default Screen ➍: No video or profile picture is 
displayed, only a default screen with information and 
various commands. 
Video ➎: You have Start Video enabled and it shows your 
camera feed (to everybody in 
the meeting). 
Profile Picture/Name ➏: You 
have Stop Video enabled and 
now only your profile picture or 
just your name is displayed (to 
everybody in the meeting). 
Screen Share ➐: You have 
Share Screen enabled and that  
shared portion of your screen 
(that everybody in your 
meeting can see) now has a 
green frame around it. 


Meting Controls: 
The Meeting Window is the one that shows the important Meeting Controls ➑, the control bar that you use 
during a meeting. 
The Meeting Controls are automatically displayed when you move your mouse cursor over the Meeting 
Window or you keep them always visible by selecting from the main menu Window > Always Show Meeting 
Controls (key command   ). 


Start Window
➊


Zoom Window
➋


Meeting Window
➌


➍


➎


➏


➐


➑
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Zoom Window 


Once you signed in with your Zoom Account on the Zoom Application, you will see the Zoom Window ➊. 
Here is just a quick overview on how to navigate without going too much into details. 


Resize 


You can resize the window by dragging its 
corners or sides. When you make the window 
small ➋, you will notice that the four buttons on 
top move to the bottom and the calendar 
disappears.   


Four View Buttons 


 on any of the four View Buttons ➌ (on top 
or the bottom of the window) to switch the 
window to one of those views (Home, Chat, 
Meeting, Contacts). 


Four Meeting Button 


In the Home View  the four buttons ➍ in the center let you manage the meetings. Please note that the 
four buttons change their appearance and label depending on the status. Also, the New Meeting and Share 
Screen button have a selector ➎  to open some configuration options. 


Account Button 


The button in the upper-right corner shows your profile picture ➏ 
(if you have saved one).  on it to open the menu with various 
configuration options regarding your account. 


Settings Window 


 on the Gear button ➐  below the profile picture to open the 
Settings Window ➑ (same as selecting from the main menu 
Zoom.us ➤ Preferences or key command  ). Please be aware 
that these settings are a subset of the available settings for your 
account. If you  on the link View More Settings ➒ at the bottom of 
that window, it switches to your web browser and opens the main Settings window of 
the Zoom Web Portal for your account. 


Applications Menu 


 on zoom.us in the main menu to open the Applications Menu ➓ that contains menu 
commands (and listed key commands) for the four Meeting Buttons and other 
commands. 


➊ ➋


➍


➏
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➑


➒


➓
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➎
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Meeting Window 


The Meeting Window ➊ opens whenever you are in a meeting. It is the 
same window when you host or just join a meeting. It has a lot of features 
and functionality that I'm not going into, covering the main things to watch 
out for. 


Different Window Content 


As I showed previously, the Meeting Window can show different content 
(video, profile picture, screen share, etc.) depending on your current setting. 


Info Screen 


 on the I ➋ button in the upper left corner to open a window ➌ that 
displays all the details of the current meeting you are in (Name, Meeting ID, 
Host, Password, Invitation URL). 


Window Header 


The window header also shows you the current Meeting ID ➍. 


Meeting Controls 


The Meeting Controls ➎ is the control bar that can be placed at the bottom or top of the Meeting Window, 
displayed permanently or only when you move the mouse cursor over the window. It contains all the 
commands to manage your meeting as a host or joined participant. If the horizontal window size is too small, 
then a More ➏ button appear that, when clicked on, reveals the remaining commands. 


 


Manage the View 


Make sure you make yourself familiar with the various options to configure your Meeting 
Window: 


Gallery View vs. Speaker View ➐: Have the video window of all participants 
viewed in the same size (Gallery View) or have the current speaker take over the 
screen with the other participants on smaller windows on top (Speaker View). 
Participants Panel:  the Manage Participants ➑ button to toggle the list on the right showing all the 
participants. Here, participants can also "Raise Your Hand" to get the attention. 
Chat Panel:  on the Chat ➑ button to toggle the Chat Panel on the right. You can also "pop out"  
the Chat Panel (and the Participants Panel) as a separate floating window. More on the later. 


Meeting Menu 


The zoom.us app adds a Meeting ➓ menu to the application's menu bar 
when the Meeting Window is open. It lists most of the commands of the Meeting Controls with their key 
commands. 


End/Leave Meeting 


When you are a joined participant, you can leave the meeting by clicking on the red Leave Meeting button. 
When you are a host the button is labeled End Meeting ⓫. This will open a dialog first that gives you the option 
to leave the meeting so it can go on without you as the host (join back later) or end it for everybody. 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   (Confusing) Sign-in Procedures   


Sign In Through Zoom Web Portal 


Go the the Zoom.us website and  on the SIGN IN link ➊. 
On the next Sing In window ➋ enter the email and password of your 
account and  the blue Sign In button. 
Attention: You can't do a single-sign on (SSO) from the Zoom website if 
you have a licensed account with a company or university. For that you 
have to use your institution's dedicated sign-in website or use the 
Zoom.us application directly. 
Now you are signed in on 
the Zoom website ➌, the 
Zoom Web Portal. 


The Zoom Web Portal gives you three options 
regarding the Meetings: 


Schedule a Meeting 


 on that SCHEDULE A MEETING link ➍ to open another page where you 
can enter all the details for a meeting that you want to set up. This link 
might not be available with a Licensed account. 


Join a Meeting 


 on the JOIN A MEETING link ➎ to open a window where you can enter 
the Meeting ID of the meeting that you want to join. When you  the 
blue Join button ➏ the Zoom Web Portal will launch the Zoom 
Application ➐ on your computer with the Meeting Window ➑ open 
where you have the meeting. 


Host a Meeting 


 on the HOST A MEETING link ➒ (or move the mouse over it) and a popup window gives you options on how 
to start the meeting ➓ (with or without video, or screen sharing only). The Zoom Web Portal will launch the 
Zoom Application on your computer to host the meeting in the Meeting Window ➑. 


Zoom Web Portal


zoom.us Application
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A lot of little Details 


Zoom Web Portal vs. Zoom Application 


Again, please be aware of the two components of Zoom. 
Zoom Web Portal: This is the Zoom website where you create your account originally and also can 
start to host and join a meeting. However, as I just shown, for a meeting, the website launches the 
Zoom.us Application and that is where you actually have the meeting (not on the web browser!). That 
is why I recommend to start with your meeting (host or join) directly from the Zoom.us Application. 
Zoom.us Application: This is the standalone application. Again, once you created your account on 
the Zoom website, you can do all the meeting activities from that app. The only reason to sign in to the 
Zoom web portal is to configure specific settings. 


Allow to Open Zoom.us Application 


Pay attention to this "switch" between the two component that 
Zoom is operating on, the Web Portal and the Zoom 
Application. When you start a meeting (host or join) from the 
web you have to authorize (Allow) ➊ the switch (at least on iOS) 
due to security measures. As a host you can enable the option 
in the settings to use the web browser ➓ as the meeting 
window in case someone cannot download the app (public 
computer). 


Download the zoom.us Application 


Remember, if this is your first Zoom meeting on a computer, you 
will be prompted to download/install the Zoom.us app. 


What do you see on the Meeting Window? 


There is a slightly confusing mechanism when you start hosting ➋ a video from the Zoom Website regarding 
what is displayed on the Meeting Window: 


Host Meeting "With Video On": When you choose With Video On ➌, then the Meeting Window shows 
your camera view ➍. When you disable your camera by clicking on the Stop Video button ➎, the view 
changes to display only your profile picture ➏. 
Host Meeting "With Video OFF": When you choose With Video Off ➐, then 
the Meeting Window ➑ shows a default screen with the various 
information and buttons. Enabling your video by clicking the Start Video 
button ➒ shows your camera view ➎. Disabling your video will go back to 
the default screen ➑. However, once another participant joins the meeting, 
then the default screen switches to show your profile picture ➏. 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Sign In Through Zoom Application 


As I mentioned before, once you have created your Zoom Account and configured the main preferences on 
the Zoom Web Portal, then you should use the Zoom Application to join or host meetings. Starting from the 
web browser just requires too many steps and at the end, it switches to the Zoom Application anyways. 


Sign in or not? 


Before using the Zoom.us Application, you have to understand a few mechanisms and rules regarding the 
sign in status. 


Not Signed In 


You don't have to be signed in on the Zoom.us Application to use it. However: 
If you open the app (and are not automatically signed in), then the Start Window ➊ opens with two 
buttons. You can  the Join a Meeting button ➋ to participate in a meeting ➌ without signing to your 
account (you don't even have to have a Zoom Account). 
If you start hosting a meeting from the web browser, it launches the Zoom.us Application without the 
need to be signed in on the zoom.us app and you can still host the meeting. 
If you want to start hosting a meeting from your zoom.us app, then you have to be signed in to your 
account. 


Attention: Any setting that you configured on the Zoom Application under a specific account, for 
example, play your computer audio in stereo instead of mono (i.e., iTunes or YouTube videos), will not 
be active when you are not singed in to that account for which you made the setting. 


Signed In 


Here are the rules for signing in: 
To start hosting a Meeting from the zoom.us app you have to  the Sign In 
button ➍ on the Start Window to enter your credentials ➎. 
You can enable the Keep me signed in checkbox ➏ so you are automatically 
signed in when the application launches the next time. 
The Sign In window also gives you the SSO (single sign on) option ➐ if you 
have a licensed account. Check with your 
company or university for your login 
credentials. 
You can use the Sign In/Out ➑ command 
from the main menu to sign in to your 
account or switch to a different account. 


➊
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 3 - Zoom and Audio 


The basic audio requirements in Zoom are pretty simple. You need two things: A speaker/headphone to 
listen to the meeting and a microphone if you want to participate in the conversation. 
You can also use your cell phone's speaker and microphone to merge with your Zoom Meeting on your 
computer. I discuss that special option later. 
 


   Headphones and Microphone   


Speakers/Headphones 


To listen to the Zoom Meeting you can use any of the following options: 


Built-in Speakers: Most desktop computers and laptops have built-in 
speakers that work just fine for a quick hook-up. However, it has the 
downside of creating a feedback when the sound is picked up by the 
microphone. Also, people on the other end don't like the "speaker 
phone sound" when they hear themselves delayed as an echo.  
Connected Speakers: Your connected (book shelf) speakers might 
provide a better sound, but they still have the same disadvantage of 
possible feedback loops and echoes. 
Connected Headphones: Headphones are a better solution because 
they eliminate feedback and provide a better isolation for overall sound 
improvement during the meeting. One-sided headsets or half open 
headphones are a better choice than closed headphones, because you 
won't hear yourself in the headphones during the meeting (your signal is 
not passed through). 
Wireless Headphones: Wireless headphones (like AirPods) are a great 
solution because you are not tied to the desk via a cable. They are open 
enough that you can hear yourself and small enough that you appear in 
the video without having a big chunk of gear wrapped around your 
head. 


Microphone 


To participate in the conversation during a meeting you can use the following options regarding a 
microphone: 


Built-in Microphone: Most laptops and many desktop computers have a built-in microphone with a 
good-enough quality that you can use in a meeting. 
Headset Microphone: Telephone headsets are a good choice because they are optimized for 
speech-type communication. Some models are available as a wireless option. 
Dedicated Microphone: If you want to have the best sound, you can use a dedicated microphone 
like a radio DJ or podcaster. They come in different quality and price ranges. 
Earbuds Mic: The earbuds from your cell phone have a built-in microphone that works fine. 
AirPod Mic: The AirPods, as mentioned before, provide the freedom to walk around and are the least 
obstructive. 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   Basic Audio Setup   


Once you have your mic and speakers available or hooked up, you can connect to the meeting. 


Initial Speaker and Microphone Test 


When you use Zoom the first time, you will be guided through an easy step-by-step setup and testing 
procedure for your speakers and mic. If you have any problems later with your audio setup, you can repeat 
that procedure in the Audio Setting of the zoom.us app. 
 


Test your Speakers 


The Zoom app will play a melody. If your speakers are set up 
correctly then you should hear that sound. 
If not, then check your speaker volume, select a different 
speaker from the selector ➊ that shows all you available 
Output Devices n your computer. 
If you click the No button ➋, Zoom will automatically select the 
next Output Device. If you stepped through all of the them, 
then you will get the option to join with your audio from your 
cell phone by dialing a specific number that will be listed on 
the following page.  the Join Audio by Phone button ➌. 


Test You Microphone 


If you hear the sound and  the Yes button ➍, the next 
window opens up where you can select and test the Input 
Device, your microphone. 
Same procedure here. Select the correct Input Device from 
the selector ➎ that shows all the Input Devices ➏ on your 
computer.  the No button ➐ to have Zoom step through, or 
when you went through all of them, choose the option to 
connect with your cell phone ➌. 


Ready to go 


If everything is set up correctly,  Finish ➑ and you are ready 
to go. 


➌


➊


➋➍


➎


➏


➐


➑
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Preferences Window 


You can also test and change the mic and 
speaker settings any time in the Settings 
Window ➊ of the zoom.us app. 
Go to the main menu Zoom.us ➤ 
Preferences... 
(or use the Key Command  .) and select 
the Audio tab ➋ in the sidebar on the left. 
The test controls and displays for the 
speakers and microphone are on the right ➌. 


Meeting Window 


Once you are connected to a meeting, you can change the microphone and speaker directly from the 
Meeting Window.  on the selector  ➍ next to the speaker icon on the far left of the Meeting Controls to 
open a popup menu ➎. 


The top section displaying the Input Devices ➏ on your 
computer, all the audio sources that you can use as a 
microphone for that meeting. The currently selected device 
used as your microphone has a checkmark.  
The section underneath lists all the Output 
Devices ➐ on your computer that you can use to 
route the audio signal to that is coming from the 
Zoom Meeting. The currently selected device 
used as your speaker has a checkmark. 
The section below ➑ has a few additional commands. 
• Test your system again 
• Switch to use your cellphone as the mic/speaker 
• Disconnect your audio on your computer from the Zoom 


Meeting 
• Go to the Audio Settings Window. 


Attention: When you use Share Screen  ➒ with Computer Sound 
enabled (i.e. iTunes, YouTube videos, etc.) then that sound is NOT 
routed to this speaker setting, which I explain later. 


Zoom.us Preferences
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   Zoom Audio Setup    


There are two important settings that have to be 
configured on the Zoom Website when you log in 
to your Zoom Account ➊. Remember, these 
settings that are configured on the Zoom Web 
Portal are different settings from the settings you 
configure in the Zoom.us app! 
When signed in to your Zoom Account on your 
web browser, select the Settings tab ➋ on the left 
sidebar and scroll down almost to the end to 
enable the following two settings: 


Allow users to select stereo in their client 
settings ➌ 


Without this setting any audio during a Zoom 
meeting will be mono which is ok for speech only, but 
not for music. Please be aware that by enabling this 
setting you don't turn on stereo yet, you only add the 
checkbox Enable stereo ➏ to the Settings Window of the 
Zoom.us client app so you can toggle between Mono and 
Stereo, but only if you are signed-in to your account on the 
Zoom app! 
Now switch to the Zoom.us client app (sign in to your 
account) and open the Settings Window ➍ from the main 
menu  Zoom.us ➤ Preferences... (Key command  ). Select 
the Audio tab ➎ on the left sidebar and you should now see 
the checkbox Enable stereo ➏ on the window. You can even 
toggle between stereo and mono during an ongoing 
meeting. If you are not signed in to your account on the 
Zoom app, then audio will be transmitted in mono! 


Allow users to select original sound in their client 
setting ➐ 


Zoom is using some special algorithm to "improve" the audio 
transmission. It seems that this is optimized for speech 
content and you have to turn it off to make sure that it doesn't 
apply speech algorithms to music. The effect on music is 
pretty dramatic. It reduces low frequencies and adds 
phasing/tunnel effects typical in VoIP data compression. 
Again, enabling this setting in the web portal ➐ only enables 
the option to do so. Once enabled, you should 
see a checkbox ➑ in the Advanced Audio 
Settings (click on the Advanced button to go to 
the second page!). When enabled, a button 
appears in the upper-left corner of the Zoom 
Meeting Window "Turn on/off Original Sound" ➒, 
plus a selector ➓ to choose an Audio Input that 
always has that function enabled. 


➊


➋


Zoom Web Portal
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Computer Sound 


With video conferencing like a Zoom Meeting ➊ every participant just needs a mic ➋ and speakers 
(headphones ➌) to carry the conversation. However, if you want to play sound/music via applications on your 
computer ➍ (iTunes, Browser, QuickTime, etc.) so other participants ➎ in that meeting can hear that, then a 
few more steps are involved. 
The basic setup in the Zoom app is as simple as enabling the checkbox Share computer sound ➏ and Zoom is 
doing the rest behind the scene. Best case scenario, everything is working and you can play your YouTube 
video or QuickTime video with sound and everybody can hear it. However, there are a lot of little details 
happening behind the scene. I illustrate the mechanism on this diagram and will explain on the next few 
pages the individual steps that you have to pay attention to, especially if you want to use DAWs ➐ like a Pro 
Tools Session in your Zoom meetings. 


Safari 
(YouTube)


iTunes


QuickTime


System Audio


Pro Tools


Logic Pro X


Playback Engine


Audio Device


ZoomAudioDevice


Zoom.us App


Zoom Participants


Volume/Mute
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➍


➎
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Computer Audio vs. Computer Sound 


Zoom uses two important terms, Computer Audio and Computer Sound  that you have to pay attention to in 
order to understand what is really happening regarding the audio signal that is (re-)routed inside your 
computer and between your computer and other Zoom participants. 


Computer Audio  


Before explaining the term Computer Audio, you have to understand yet another piece of the Zoom 
architecture regarding the audio signal. 
When using the Zoom.us app on your computer, you have two options on how the app handles the audio 
signal (mic, speakers). 


Computer Audio: By selecting the option Join With Computer Audio ➊, you tell the Zoom app to use your 
computer mic and speaker (or however you routed your audio signal on your computer). The 
Meeting Window will show the Mic icon ➋ to indicate that you use Computer Audio. 
Phone Call: When you select the Phone Call ➌ option, you can use any of the listed numbers ➍ to call 
into that session with the listed Meeting ID ➎. Please note that this creates a new independent 
meeting participant but with your Participant ID you can merge ➏ your Phone call with your Zoom 
app so it is using the Phone mic and speaker. In that case, the Mic icon ➋ on the Meeting Window 
changes to the Phone icon ➐. 
None: There is technically a third status where the Zoom app isn't using any audio (mute all audio, for 
example when in conference room settings). In that case, the icon will show a Join Audio icon ➑. 


Computer Sound 


The term Computer Sound refers to a specific portion of the audio routing on your computer. It is technically 
a special configuration of the Computer Audio that does not apply when you use your phone (mic, speaker) 
with your Zoom app. On the next pages I will further explain the "consequences" when using Computer 
Sound. 


Phone Audio
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   Zoom Meetings with Audio   


Scenario 1: Mic Only   


Let's look at the first scenario of a Zoom Meeting: 
This is a basic meeting where the only audio signal on your computer that is sent to the other Zoom 
participants during a meeting is your mic signal ➊ (or whatever you selected in the menu ➍). 


 


Audio Menu 


 on the selector  ➋ next to the Mic icon to open the Audio Menu. 
Select a Microphone: The top section ➌ of the menu displays all the Audio 
Devices available on your computer that represent an audio source. That's 
where you select your microphone ➍ or the device that has a microphone 
connected to use for that meeting. 
Select a Speaker: The section below ➎ displays all the Audio Devices 
available on your computer that represent an audio destination. That's where 
you select your speaker or the device that has a speaker or headphone ➏ 
connected so you can listen to other participants. 
Others: The remaining menu commands ➐ are for audio configuration. 


Please note: 


You can see on the routing diagram ➑ that your microphone signal will not 
be passed on to your own speaker/headphone. Only the signal coming back 
from other participants (maybe don't use closed headphones). 
The Mic icon has a tiny level indicator ➒. It fills up green when signal is coming 
in. 


 on the Mic Icon ➓ to toggle Mute/Unmute of your audio signal (   ). 
You can hold down the spacebar on your keyboard to temporarily unmute the mic, like 
a talkback button. A little mic overlay ⓫�appears indicating a microphone signal (must 
be enabled in the Zoom app's Audio Settings). 
Any other "internal" audio on your computer (YouTube, iTunes, etc.) will not be 
transmitted to the Zoom participants, only the audio source that you selected from the 
menu. 


➋
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Scenario 2: Mic AND Audio from Applications   


If you want to send the audio output of your iTunes app, your web browser (playing YouTube), or any other 
app that plays an audio signal so other participants can hear it, then you have three options: 


Play Through Microphone: If you crank up your speaker on your computer, then your microphone 
will pick up that sound and transmits it to the other participants. Although it works, that does not 
deliver a good audio quality. 
Use "Computer Sound" option: Zoom has a special functionality built in, called  Share computer sound 
➊ that can be enabled with the Share Screen function . This will send the System Audio on your 
computer together with your Mic signal to all participants. 
Use special Routing options: You can use special (advanced) routing on 
your computer to overcome the restrictions with the Share computer sound 
option (i.e. 48kHz Sample Rate only). 


Screen Sharing 


When you enable screen sharing (  on the green Share Screen button  
➋), the Share Screen Setup Window opens with a checkbox Share computer 
sound ➌ in the lower-left corner. This is what happens: 


Disabled: Audio from any app on the shared screen will NOT be 
transmitted to other Zoom participants. Only the selected 
Microphone is active (which can be muted). 
Enabled: A couple of things will happen: 


• If this is the first time you use that feature, a Dialog should open asking 
you to install the ZoomAudioDevice (requires admin privileges) ➑. 


• When you  the Speaker icon ➍ in the macOS Menu Bar (or you can 
go to the Audio System Preferences), you will see a new Audio Output 
Device called "ZoomAudioDevice" ➎. 


• The Zoom app automatically switches the System Audio to that 
ZoomAudioDevice when you enable the Share computer sound checkbox 
➌ and switches back to the previous Audio Devices when you uncheck 
that option again. 


• Once Screen Sharing is enabled the Share Screen ➋ button  changes 
to the New Share ➏ button.  on it to open the Share Screen Setup 
Window again to choose a different option (without disabling Screen 
Sharing) or toggle the Share computer sound checkbox. 


•  the red Stop Share button ➐ to 
disable Screen Sharing and the 
Computer Sound (not the Mic). 
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Computer Sound Only Screen Sharing 


There is one special mode in Zoom to enable Computer Sound without actually sharing your screen. 
 on the green Share Screen button  ➊. 
 the Advanced button ➋ on top of the Share Screen Setup Window to switch to the Advanced Page. 
 the big Computer Sound Only tile to enable it. 


The checkbox Share computer sound ➍ doesn't have to be enabled. It is actually grayed out. 
 the Share button ➎ to enable the Computer Sound Without Screen Sharing Mode. 


Please note that technically Screen Sharing is not enabled 
but Share Computer Sound is. 
To stop sharing your Computer Sound, click on the red Stop 
Share button➒ on top of the 
Meeting Window that appears 
when that mode is enabled. 


Attention 


There are a quite a few little details you have to be aware of when using the Computer Sound option 
Audio to Participants: As long as Screen Sharing is active, all applications that use the System Audio 
as their audio output route their audio to the ZoomAudioDevice ➏ and, therefore, that audio signal 
will be sent to all Zoom participants. 
Audio to own Speakers: The ZoomAudioDevice also routes the System 
Audio to the Audio Destination (most likely your headphones or 
speakers) that you have selected in the Zoom Audio Menu of your Zoom 
Meeting Window. That is the same destination that all audio from 
incoming Zoom participants is routed to. This guarantees that you hear 
the audio of your applications yourself. 
Muting Mic: Muting the Speaker Icon (   ) will mute your 
microphone (the Audio Input selected in the Audio Menu) but not the 
Computer Audio (Safari, iTunes, etc.). 
Muting Computer Audio (Level Change): Because the 
ZoomAudioDevice is a regular CoreAudio component, any volume 
changes or mute on your computer via the Volume Fader ➐ or the Volume 
Buttons ➑ on your computer keyboard also affect the signal level that is 
sent to the meeting participants. However, this will not affect the microphone 
signal that is sent to the participants. 
Enable/Disable: Turning off Screen Sharing will disconnects the feed 
of your Computer Sound (iTunes, QuickTime, YouTube, etc.) to the 
meeting participants. During an active Screen Share, you can click the 
More button on the Meeting Controls to open a popup menu that lets 
you toggle Share computer sound ➓. 
Independent Audio Routing App: Any application that selects their 
own Audio Device and does not follow the System Audio Setting (i.e., Pro Tools, Logic Pro X, Skype, 
etc.) will not follow the Share Computer Sound routing. To route their output to the meeting 
participants you have to manually select the Audio Device "ZoomAudioDevice" in that app (i.e. 
Playback Engine Dialog in Pro Tools). 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Scenario 3: Playing Pro Tools (or other DAWs)   


DAW and some other audio application can select their own Audio Device independent from the System 
Audio. To play back their audio output to the meeting participants you have to pay attention to the following 
things:  


You have to select ZoomAudioDevice as the Audio Device in that application. 
The ZoomAudioDevice functions as an Output Device and also as an Input Device, feeding the 
System Audio to those inputs (don't use it as an input!). 
The ZoomAudioDevice operates ONLY with a Sample Rate of 48kHz, which means you can only play 
back DAW Sessions set to that Sample Rate 
Share Screen in the current  Zoom Meeting has to be enabled so you can see that device. 


Pro Tools 


Here are the settings for Pro Tools: 
In the Playback Engine Dialog, select 
ZoomAudioDevice ➊ as the Playback Engine. 
When you create a new Pro Tools Session in the 
Dashboard Dialog, you will see that the Sample Rate 
is grayed out with a label "48 kHz (ext. Clock)" ➋ 
because the ZoomAudioDevice only operates 
with that Sample Rate. 
If you have a Pro Tools Session recorded in a 
different Sample Rate and want to play it back in 
your Zoom Meeting, you have to use the 
advanced routing setting that I explain in the 
Advanced Routing chapter. 


Logic Pro X 


Here is the setup in Logic Pro X: 
In the Audio Preferences select ZoomAudioDevice ➌ 
from the Output Device Selector. 
You could also select the System Setting ➍ and then 
Logic automatically chooses whatever Audio Device 
is selected for the System Audio. Remember, Zoom 
automatically switches the System Audio to 
ZoomAudioDevice.

The same restriction applies for the Sample Rate. Only 
48kHz is available in the Project Settings > Audio > 
General ➎. All other options are not available (italic) ➏. 


Other DAWs 


The configurations are similar for other DAWs like Ableton, Studio One, or applications that can select their 
own Audio Device independently from the System Audio. 


Pro Tools Playback Engine Dialog


➊


Pro Tools Dashboard Dialog


➋


48kHz only


➎


➏


Logic Project Settings ➤ Audio


➌


➍


Logic Preferences ➤ Audio
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Scenario 4: Playing DAWs in 44.1kHz 


If your DAW session uses a Sample Rate of 44.1kHz, then you have to use an Aggregate Device to "force" the 
ZoomAudioDevice to switch from 48k to 44.1k. 


Create Aggregate Device 


First, you have to create a new Aggregate 
Device in the Audio MIDI Setup utility: 


Open AMS: Launch the utility app 
Audio MIDI Setup (located in the Utilities 
folder inside the Applications folder) and 
open its Audio Devices Window ➊ (key 
command  ). 
Create a new Aggregate Device:  


 on the plus button in the lower left 
corner and select Create Aggregate Device. 
It will be added to the Sidebar on the 
left ➋. 
Name it:  the new Aggregate 
Device and name it "Zoom 44k Aggregate". 
Select "ZoomAudioDevice": It is important 
that you first  on the checkbox of the 
"ZoomAudioDevice" device so it will move to the 
top of the list ➌. 
Select "Built-in Output": Then,  the 
checkbox for the Built-in Output ➍. We don't 
necessarily use that device, but we need it as 
the Clock Source. 
Clock Source: On top of the window  on 
the selector next to the Clock Source and 
choose the Built-in Output ➎ from the menu. 
That means, whatever Sample Rate you select 
for that Device, that will be the Sample Rate 
for this Aggregate Device and "force" it to the 
ZoomAudioDevice. 
Sample Rate:  on the selector Sample Rate and 
choose 44.1kHz ➏ to set the Sample Rate of the Built-in 
Output (and therefore the Zoom 44k Aggregate) to 44.1kHz . 


Pro Tools 


Now you can launch Pro Tools to do the necessary settings: 
In the Playback Engine Dialog select the Zoom 44k Aggregate ➐ device as the Playback Engine. 
In the I/O Setup Dialog delete the current Output Paths and  the Default button to list the output 
channels of the current Playback Engine. Now Out 1-2 ➑ represents the ZoomAudioDevice included in 
the "Zoom 44k Aggregate" device ➌. 
Launch your 44.1kHz Session or create a new one with a Sample Rate of 44.1kHz. 
In your Session select Out 1-2 ➒ from the Output Path Selector on the Master Fader Track (and all the 
corresponding Tracks depending on your routing). They will be routed to Zoom and all the 
participants in the Meeting via 44kHz when you enable Share Screen with Computer Sound selected. 


Audio MIDI Setup:Audio Devices


Pro Tools: Playback Engine Dialog


Pro Tools: I/O Setup Dialog


Output Path Selector


> ZoomAudioDevice


➊


➋


➌


➍


➎
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➐


➑


➒
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   Logic Pro X   


The configuration for the Aggregate Device in the previous example works for Pro Tools but not for Logic Pro 
X. There seems to be a bug regarding the Aggregate Device and the ZoomAudioDevice that whenever Logic 
launches, the Sample Rate of the Built-in Output device switches to 48kHz. 
Here is a slightly different configuration of the Zoom 44k Aggregate device that avoids that problem. 
Unfortunately, this requires an extra step in the routing setup of Logic Pro X. 


Create Aggregate Device 


The first few steps to create the Aggregate 
Device are the same, we just configure the 
Zoom 44k Aggregate device differently. Please pay 
attention to the order of the devices "inside" 
the Aggregate Device because that is 
important. 


First, make sure all the checkboxes of 
the devices are deselected. 
Enable the checkbox next to the Built-in 
Output ➊ so it becomes the first device 
on the list. 
Enable the checkbox next to the Built-in 
Microphone ➋ so it is the second device 
on the list. I guess this will prohibit the 
ZoomAudioDevice input device (operating in 48k) switching 
Logic's Sample Rate. 
Enable the checkbox next to the ZoomAudioDevice ➌ so it is the 
third on the list. 
Make sure the Built-in Output ➍ is selected on top as the Clock 
Source. 
Select 44.1kHz as the Sample Rate ➎. 


Logic Pro X 


Launch Logic Pro X without any Project open. 
Open the Logic Preferences, go to Audio ➤ Devices and 
choose the Zoom 44k Aggregate ➏ device  from the Output 
Device selector. 


Output Routing 


Here is the important part about the output routing: 
I assume that your Channel Strips in your Project are routed to Stereo Output. 
That Stereo Output is not an output channel of your Audio Interface, it is a placeholder (like a 
Monitor Path in Pro Tools) that, by default, is set to the first two audio channels of your selected Audio 
Interface ➏. 
Because the output channel we want to use (ZoomAudioDevice) is output channel 3-4 ➌ on our selected 
device Zoom Aggregate 44kHz. we have to configure Logic accordingly. 
In the Logic Preferences go to Audio ➤ I/O Assignments ➤ Output,   on the Output selector and 
choose Output 3-4 ➐. 
Now all Channel Strips that are set to Stereo Output in your Mixer are routed to the output channel 
3-4 of our Zoom 44k Aggregate device and, therefore, send to the Zoom meeting participants via Share 
Screen using Computer Sound with 44.1kHz. 


Audio MIDI Setup: Audio Devices


Logic Preferences ➤ Audio 


Logic Preferences ➤ Audio 


> ZoomAudioDevice
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4 - Collaboration 


  Share Screen   
In the previous scenarios, I already used the Share Screen option. Here are a little more details about that 
feature: 


Interface 


Share Screen Button 


Every participant has the green Share Screen button  ➊ on the Meeting 
Controls of their Meeting Window, not matter if they are the host or just join 
a meeting. The host has control over who to allow to share their screen. 


 on the Share Screen Button to open the Share Screen Setup Window ➋, 
where you determine what you want to share and start the screen sharing. 
Instead of clicking the Share Screen Button, you can also use the key 
command    or the menu command Meeting ➤ Start Share ➌. 


Share Options Menu 


The host of the Zoom Meeting also has a selector  ➍ next to the Share Screen 
button that opens a menu ➎ with options regarding the Share Screen feature. 


 


Settings 


The Zoom Settings (  ) has a section ➏ to configure 
some aspects of the Share Screen feature. 


Meeting Controls


Share Screen Setup Window


➊


➋


➍


➎


➌


Zoom Main Menu


➏


Zoom Preferences
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Share Screen Setup Window 


The Share Screen Setup Window determines what you gonna share and how: 
The available options are available as tiles that function as buttons. You select or . 
The tiles are spread over two pages that you select by clicking on the Basic ➊ or Advanced ➋ tab on top. 
• Desktop ➌: This shares your entire computer screen, whatever you see, the participants see. 
• Any Window ➍: Any window from any app that was visible when you clicked the Share Screen 


button, will be displayed as a separate tile, so you can share only that window and nothing else on 
your desktop. 


• Portion of Screen ➎: You can draw a box on your desktop and only that section will be shared. You 
can move and resize that box to focus on a specific section of your screen. 


• Content from second screen ➏: You can select a second screen to share if available. 
• iPhone/iPad ➐: You can share the display of your iPhone or iPad either via AirPlay or connected via 


cable to your computer (use it as a live camera). 
• Computer Sound Only ➑: This option (as described in the previous chapter) only shares your 


System Audio but not any screen. 
• Whiteboard ➒: This opens a whiteboard with drawing controls that you can draw on or let 


participants give control over to draw on it. 
The bottom of the screen has two checkboxes ➓.  
• Share computer sound: This enables the System Audio to also transmit any audio from your apps (i.e. 


YouTube videos) in addition to the screen share. I explained that in the previous chapter. 
• Optimize Screen for Video Clip: For a better full-screen viewing experience. 


 the blue Share button ⓫ to start Screen Sharing with the selected options. 
 on the red dot in the upper-left corner to close the window without enabling screen sharing. 


Screen Share Setup Window


➊


➋


➌


➍


➎
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⓫
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Share Screen Options 


The host has an additional selector  ➊ on the Meeting Controls next to the Share Screen button  that 
opens the menu with the following options: 
 


 


One participant can share at a time ➋: That means if someone 
wants to start sharing their screen a warning pops up 
reminding that a current screen share from any participant 
will be disabled. 
Multiple participants can share simultaneously ➍: Although any 
participant can now start sharing without kicking anybody 
off, the outcome of this option depends on various other 
conditions:  


• If you have two monitors, then you can see the two most recent shared screens. 
• If you have only one computer screen, then the section Shared Screens ➎ appears on the View 


Options menu ➏ on top of the Meeting Window of any Meeting participant. It lists all the 
currently shared screens that you can select to be displayed on your computer. 


• If you are on an iOS device, then you can see only the most recent shared screen. 
Advanced Sharing Options ➐: This command opens another window with even more (slightly confusing) 
options. The first two options ➑ are the same as from the previous menu ➋ ➍. The options below ➒ 
determine various sharing rules. 


 


➌


Meeting Window of participant viewing a Shared Screen


➎


➏


➊


➋


➍


➐


➑


➒
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Share Screen Status 


Active Screen Sharing 


Once you enable Share Screen  on your computer, there are quite a few things that change or work 
differently: 


Share Screen Strip: Your standard Meeting Window (where you see the 
video of yourself and the participants) will change to a single Share Screen 
Strip ➊. It contains the following information: 


• An arrow to move the strip to the bottom or top of your screen 
• The Meeting ID 
• A speaker icon indicates that you are sharing your Computer Sound 


(System Audio) 
• Red Stop Share button 


Meeting Controls: The functionality of the Meeting Controls ➋ is still the same. They are now 
attached to the Share Screen Strip ➊ and appear only when you move the mouse over it or they are 
always visible if you have it enabled  Window ➤ Always show Meeting 
Controls (  ) ➌. 
• The size of the Meeting Controls is fixed and all additional controls are 


available from a popup menu when you click on the More ⓫�button on 
the far-right. 


• The Meeting Controls (together with the Share Screen Strip) can be 
shown/hidden View ➤ Show/Hide Floating Meeting Controls ➍. 


Shared Screen: The portion of the desktop that you share will have a green frame ➎ around it. 


 


Video Panel: A small Video Panel ➏ shows the video of yourself and 
the participants. This is the content that is usually displayed in the 
Meeting Window when Share Screen is not active. The three (or four) 
buttons ➐ on top let you change between, name of current speaker, 
video of current speaker and videos of all participants. 
Chat and Participants Panel: The Chat Panel ➑ and 
Participants Panel ➒ are only displayed as separate 
floating windows and can be toggled with various 
commands ➍ (i.e. More button ⓫ on the Meeting 
Controls). 


➍


➌


➏


➑
➒


➐


➊


➋


➎


➓


⓫







Zoom.us - How it Works with DAWs (2020-0412)   of 37 77


Share Status 


When you share your screen, you have to pay attention to the different status of your screen share indicated 
by the changing appearance of the Share Buttons and the Share Screen Strip on the Meeting Controls. 


Not Shared 


This is the status when Share Screen is not 
enabled. You will see the green Share Screen 
button  ➊. If you are the host (or co-host), then you will see the additional selector  ➋ that opens the 
Share Screen Options Menu when you  on it. 


Active Screen Share 


Once you have Share Screen active (   
) by sharing your screen, your iPhone, or 


just the Computer Sound, the following will 
change on the Meeting Controls: 


Share Screen Strip: The Share Screen Strip ➌ appears below the Meeting Controls. 
Change Screen Share: The green button is now labeled New Share ➍. That means by clicking on that 
button, the Share Screen Setup Window opens again where you can choose a different Screen Share 
option (i.e., share different window) without interrupting your screen share to the other participants. 
Pause Screen Share: Once you activated Share Screen, a new button Pause Share ➎ will appear on the 
Meeting Controls.  that button to pause the active Screen Share (   ). 


Paused Scree Share (freeze) 


A Paused Screen Share is like a freeze frame. 
Once you  the Pause Share ➎ button   
(   ), the content of your shared 
screen is frozen on all the meeting 
participants. That means, now you can change anything on your side (on that portion that is shared), but the 
participants will not see it. They still see the frozen screen. 
During the paused status, the following will change on your side: 


Resume Share: The green Resume Share ➏ button appears that lets you continue with the screen share 
when you  on it (   ). 
New Share: The now white New Share ➐ button opens the Share Screen Setup Window to select a new 
option while still in pause. The participants will see the new sharing only once you resume sharing. 
Yellow Sharing Strip: The green sharing strip turns yellow ➑ with the message Your screen sharing is 
paused. 
Shared Window Frame: When you share a portion of you screen, it will have a green frame around it 
to indicate what section is shared. When in pause mode, that frame changes to orange to indicate that 
any changes you make (content or screen size) will not be shown to the participants. 


Automatic Pause 


The pause status can also be enabled 
automatically, for example, if you hide a 
specific window from your desktop that you 
are currently sharing. The yellow sharing strip 
will tell you that with the following text Sharing is paused. Bring your shared window to the front ➒. 


Stop Sharing 


 on the red Stop Share ➓ button (   ) to stop Screen Sharing at any time. 


➊
➋


➏➐


➑


➒


➌
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Interface 


As you have seen on the previous pages (and maybe experienced already in your own Zoom Meetings), 
figuring out what the Meeting Window actually displays and how to control what you want to see can be a 
little bit tricky. There are so many possibilities, automatic adjustments, and hidden features with the interface 
that it gets confusing, especially when you use the Share Screen feature. 
I will show on the next few pages the various changes of the interface based on the different status. 


Zoom Session without Screen Sharing  


In the standard Meeting Window (Screen Share not enabled) you can choose between two views, Speaker 
View and Gallery View.  
 


Speaker View 


The Meeting Window has the following sections: 
All Participants ➊: The top shows video thumbnails of all  participants. The participant that is currently 
speaking has a yellow frame around it. If you resize the Meeting Window so it cannot display all the 
participants (or there are too many), then a left and right arrow ➋ appear to step through. 
Current Speaker ➌: The big video screen in the center displays the video of the currently speaking 
participant. Zoom automatically switches based on the incoming audio signal from the participants. 
Meeting Controls ➍: The Meeting Controls at the bottom only appear when you move the mouse 
cursor over the Meeting Window, or you can have it always displayed (  ) ➎. 


If you switch to Full Screen (  on the center video ➌), then the speaker video 
will take over the entire screen and the participants thumbnails ➊ are now displayed 
on a floating Video Panel ➏. It has three (or four) buttons on top (visible only when the 
Meeting Controls are visible). This is the functionality of the three buttons ➐: 


Only display the name of the current speaker 
Only display the (resizable) thumbnail video of the current speaker 
Display all participants as thumbnail video with the marked current speaker ➑  


Participant


Participant


Participant


Speaker


Video Panel ➏


➐


➑


Speaker


Participant Participant Participant
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Gallery View 


 on the Gallery View ➊ button in the upper-right corner to switch to Gallery View. The Meeting Window now 
shows the following elements: 


All Participants: In Gallery View the Meeting Window displays the video of all participants in the same 
size. ➋ If you resize the Meeting Window so it cannot display all the participants, then a left and right 
arrow ➌ appear to step through. 
Current Speaker ➍: The video of the current speaker has a yellow frame around it. 
Meeting Controls ➎: The Meeting Controls at the bottom only appear when you move the mouse 
cursor over the Meeting Window or you can have it always displayed (  ). 
Full Screen: The view in Full Screen is the same, just bigger videos. 


 


Video Menu 


When you move the mouse cursor over a video frame a blue double button will pop up. 
The Mute/Unmute button ➏ and the  button ➐ that opens a popup menu with additional 
commands. This is available in Speaker View and Gallery View. The commands in the 
menu are slightly different for host and participant video. 


Mute/Unmute Audio: You can mute a participant video but unmuting will only pop up a request on 
the participant screen to unmute it . 
Start/Stop Video: You can stop a participant video but so start a video will only pop up a request on 
the participant screen to start the video it. 
Pin/Unpin Video: The Pin Video command overwrites the mechanism where Zoom automatically 
selects the participant video with the incoming audio as the speaker video. Now the selected video 
(yours or some other participant) remains the speaker video until you remove that status. 
Spotlight Video: This is a command only available to the host. If enabled, the video of the spotlighted 
participant will be pinned as the Current Speaker on each participant's Meeting Window. 
Hide/Show Self Video: This command is available for each participant to hide their own video. 
Other commands: Besides the Rename and Edit Profile Picture command, the host has additional 
commands to apply to a participant. Make Host, Make Co-Host, Allow Record, Remove, Put on Hold. These 
commands are also available in the Participants Window. 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Participants Panel & Chat Panel 


There are two windows in addition to the Meeting Window, the Participants 
Panel and the Chat Panel. There a lot of little details about them: 


Embedded or Floating: Both windows can be part of the Meeting 
Window on the right side (merge to Meeting Window ➊) or they can be a 
standalone floating window. 
Open/Close: You can open or close them with 
different commands. The window remembers if 
it was open as a floating or embedded window. 


 on the Manage Participants button ➋ or 
Chat button ➌ on the Meeting Controls. 
Use the command from the main menu View ➍ 
Use the key commands 


Embedded: If the windows are embedded in the Meeting 
Window, then they are placed in the same space on the right. You 
can resize the divider line ➎,  on the selector  ➏ and choose from 
the popup menu to Close, Minimize/Expand, or Pop Out as a floating window. 


Participants Panel 
• The window shows a list of all meeting 


participants and their video and audio status ➐. 
• The bottom of the window shows nonverbal 


feedback icons ➑ that each participant can click 
(select one at a time). In addition to the icons 
showing up next to each participant (when 
selected, the host sees the total number for each 
selected icon (response) for quick surveys. 


• Moving the mouse cursor (host only) over a 
participant shows the Mute/Unmute and the More 
button ➒ that opens a menu with more 
commands to manage Participants.  


Chat Panel:  
• The Chat Panel ➓ allows participants to send text 


messages between each other (or to everybody) 
during an ongoing meeting. 


• As a host you can set the privileges ⓫ who can 
chat with whom.  


• The text can be saved with the Meeting.  
• You can also upload files up to 512MB to the Chat 


so other participants can grab files from the Chat 
Panel. 
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Zoom Session with Screen Sharing - "Presenter" 


Here is how the Meeting Window and the visual elements change on your computer when you share your 
screen  (you are the presenter). Again, any participant can share their screen in the Meeting as long as the 
host permits it. 


Shared Screen 


Once you enable Share Screen , you should see an indication what part of your screen is shared, which 
means which part of your screen is visible to all other participants in your meeting. If you share a specific 
window or your desktop, you will see a green frame ➊ around it. If you use the option Portion of Screen ➋, then 
you will see a green box ➌ that you can drag/resize over any section of your screen. 


Advantage of "Portion of Screen" 
Keep in mind that the content of the green Screen Share Frame on your screen is 
what the participants see on their end in their Meeting Window. If you share a 
screen or a desktop, then the details of that window might be hard to see if a 
participant has a small computer screen or resizes their Meeting Window even 
further. 
When you use the Portion of Screen ➋ option in the Share Screen Setup Window, 
you can use it to zoom in on sections of the screen by resizing that box to the section 
that you want to focus on. Remember, the screen size on the participant side stays 
the same, it adjusts (auto zoom) what is displayed inside. 


Meeting Window 


Your standard Meeting Window disappears! 


Floating Meeting Controls 


The Meeting Controls ➍ remain visible 
(now as a floating panel) depending on 
your setting. However, this is were it gets 
confusingly inconsistent. 


Always Show Meetings Controls ➎: This command is under the main menu 
Window and works as usual. But, the word "always" is misleading because it 
depends on another command (Show/Hide) that is only available when 
you enable Share Screen. 
Show/Hide Floating Meeting Controls: This command in the main menu View ➏ 
(and the More ➐ button in the Meeting Controls) toggles the visibility of 
the Meeting Controls (including the Share Screen Strip). So if you don't 
see those controls, make sure to check that status. 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Share Screen Strip 


This control strip is attached to the Meeting Controls.  
Top/Bottom Arrow ➊:  on the arrow to move 
the Meeting Controls with the Share Screen Strip 
to the top or bottom of your screen. You can also 


 it anywhere on your screen. 
Meeting ID ➋: This is the Meeting ID of your current Meeting.

Speaker symbol ➌: If the participant who shares the screen also shares the Computer Sound. 
Encryption Indicator ➍: Your meeting, including the screen share, are encrypted over the Internet. 
Stop Share ➎:  the red Stop Share button to end your screen sharing. 


Video Panel 


The Video Panel is a floating window, like a miniature Meeting Window. It can be shown/hidden with the 
command from the View menu ➏ or from the Meeting Controls,  the More button and select it from that 
menu ➐. 
The panel has up to four buttons on top. The visibility follows the setting Always Show Meetings Controls.



Hide Thumbnail Videos ➑: The panel only shows the name of the current speaker. 
Show active Speaker Video ➒: The panel shows the video of the current speaker. Move the mouse 
cursor over it and you will see resize controls and additional controls for that participant. 
Show Thumbnail Videos ➓: The panel shows a strip with video thumbnail of many participants 
(depending on your screen) with the current speaker 
highlighted. Move the mouse cursor over it for additional 
controls for that participant. The strip automatically adjust 
to vertical or horizontal depending on where you move it 
on the screen. 
Show Gallery View: If you have a lot of participants in 
your meeting, then a fourth button appears to switch to 
Gallery View ⓫�that you can resize to 
view all participants. 


 


Participants Panel and Chat Panel 


The Participants Panel and Chat Panel can only be displayed as floating windows 
because there is no Meeting Window to be merged with. Use the command 
from the View menu ➏ or the key commands. 
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Zoom Session Share Screen - "Receiver" 


If someone in the meeting shares their screen, then the Meeting Window on all other participants will 
change. Be aware, there are so many options and hidden configurations that this could be the most 
confusing part of a Zoom Meeting. 
I will show these different viewing options on the next few pages. 


View 1a - Default 


This is the default view when you haven't changed any viewing options. It is the 
Meeting Window that you can resize as usual. Here the components: 


Shared Screen ➊: The big section in the center displays the content of the 
Shared Screen. 
Participants ➋: On top is the row with video thumbnails of all the participants. 
The current speaker ➌ has a yellow frame indication and if there are more 
participants than van be viewed, then you will see the arrow ➌ on the left and 
right to step through. 
Meeting Controls: At the bottom 
are the Meeting Controls ➎. 
Remember its functionality. They 
only appear when you move the 
mouse cursor over the Meeting 
Window or you have Always Show 
Meeting Controls enabled in the 
Window menu ➎. 
Share Screen Strip: The Meeting 
Window displays a new 
component, the Share Screen 
Strip ➏, once a participant shares 
his or her screen in the meeting. It 
is located on top (on the Window 
Header) and is only be shown 
whenever the Meeting Controls 
are shown. It displays the following 
elements: 


• Information about the shared 
screen: You are viewing "NameOfParticipant screen. 


• Speaker symbol: If the participant who shares the screen also 
shares the Computer Sound. 


• View Options: This selector lets you open a menu ➑ with important 
viewing options. Some menu items are only displayed under certain 
conditions.  


Participants Panel & Chat Panel: The Participants Panel and Chat Panel ➒ can 
be viewed as: 
• Part of the Meeting Window on the right (merged)  
• Standalone floating panel (pop out) 


View Options: 
• The Shared Screens ➓ section in the View Options Menu is only displayed when multiple participants share 


their screen at the same time and you can select which one to view.  
• The red Stop Participant's Sharing ⓫�command is only available to the host. 
• Disabling Follow presenter's pointer lets you drag the visible content of the shared screen in case you are 


viewing only a portion of it due to your resized Meeting Window. 


➏


➒


Participant Participant


Shared Screen


Participant


➊


➋
➌


➍


➎


➐
➑


➓


⓫







Zoom.us - How it Works with DAWs (2020-0412)   of 44 77


View 1b - Default  (Full Screen) 


When you switch to Full Screen Mode (  on the  in the center), then you will see the following: 


Shared Screen ➊: Only the Shared Screen will be visible with the size depending on your zoom setting 
in the View Options Menu ➋. 
Meeting Controls ➌: The visibility of the Meeting Controls depends on the setting Always Show Meeting 
Controls in the Window menu. 
Share Screen Strip: The visibility of the Share Screen Strip follows the 
visibility of Meeting Controls. 
Video Panel: Participants can only be shown in the floating Video Panel ➍. 
You can toggle from the View Options Menu on the Share Screen Strip 
Show/Hide Video Panel ➎.  
Participants Panel and Chat Panel: These panels can only be opened as 
floating windows with the usual commands (View Menu or buttons on the 
Meeting Controls). 


Exit Full Screen just  on the Shared Screen. 
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Participant


Participant


Participant


Speaker


Speaker
Speaker
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View 2a - Swap 


When you  the little Swap Icon ➊  in the upper-right corner of the Meeting 
Window, you will swap what is displayed in the center and in the upper portion. 


The center now shows the video of the current speaker ➋ 
The upper section shows the the Shared Screen ➌ 
The View Options Menu has less option s now ➍ 
To return to the default Meeting Window  on the Swap Icon ➊  again 
or the button Switch to Sharing Content 
that appears on the upper-left 
corner of the center screen ➍. 


Participants Panel & Chat Panel: 
The Participants Panel and Chat 
Panel can be viewed as: 
• Part of the Meeting Window on 


the right (merged) . 
• Standalone floating panel (pop 


out). 


View 2b - Swap (Full Screen) 


Although you can enter Full Screen in Swap mode, it doesn't make much sense because your screen now 
shows the Current Speaker in full screen and not the Shared Screen. 


Video Panel: The Video Panel ➎ can be 
toggled from the View Options Menu ➏. 
Participants Panel & Chat Panel: The 
Participants Panel and Chat Panel can be 
viewed only as standalone floating panel (pop 
out). 


Participant


Participant
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View 3 - Side-by-Side Mode - Gallery View 


When you open the View Options Menu 
and select Side-by-Side Mode ➊, you 
change the view of the Meeting Window 
to Side-by-Side Mode. Similar to the 
default Meeting Window, this mode can 
be viewed in Gallery View and Speaker 
View. 


Left Pane ➋: The left side shows 
the Shared Screen. You can 
change the size of the frame with 
the zoom factors from the View 
Options Menu ➌. 
Right Pane ➍: The right side 
shows the video thumbnails of the 
participants with the yellow frame 
indicating who the current speaker 
is. You can  the vertical divider 
line ➎ to change the width of the 
left and right pane proportionally. 
Switch to Speaker View:  on 
the button ➏ in the upper right 
corner to switch to Speaker View. 
Participants Panel & Chat Panel: 
The Participants Panel and Chat 
Panel can be viewed as: 
• Part of the Meeting Window on 


the right (merged) . 
• Standalone floating panel (pop 


out). 


View 4 - Side-by-Side Mode - 
Speaker View 


The only difference with Speaker View in 
Side-by-Side Mode is that the right pane 
now shows only one video ➐ that 
automatically switched to the participant 
who is currently speaking. 


 on the Gallery View ➑ button to switch to Gallery View again. 


Side-by-Side (Full Screen) 


 on the Shared Screen to toggle Full Screen Mode. The functionality is the 
same with the exception of the Participants Panel and Chat Panel that can only be 
opened now as floating windows with the usual commands (View Menu, key 
command, or buttons on the Meeting Controls). 
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➌
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  Remote Mouse/Keyboard Control   


Remote Mouse/Keyboard Control 


One great feature in Zoom is Remote Control which takes screen sharing one step further. 
Here is the basic concept and the rules: 


When you share your computer screen ➊ 
during a Zoom Meeting using Share Screen , 
every participant can see that portion of the 
screen ➋ that you are sharing. 
When you move your mouse 
cursor ➌, the participants can 
see your mouse movements 
(but only when it is on the 
portion of the screen that you 
are sharing ➋). A mouse 
highlight app that creates a 
circle around your mouse or 
any visual accents might be useful. 
Zoom lets you give any participant in your 
Zoom Meeting control over your screen ➍. That 
means that participant now can move the 
mouse cursor on the portion of your shared 
screen with their own mouse ➎. Other 
participants can see that mouse movement of 
that remote-control participant on that portion 
of the shared screen ➋. 
Remote Control also gives access over the 
keyboard at the same time. That means the 
participant who has remote control access can 
type on their screen or use key commands to 
control your screen. 


You as the host (or whoever is currently sharing 
their screen) have control on how you configure 
the remote control indicated by the Remote 
Control icon  on the Meeting Controls. 


 
• You can give control to a specific Participant. 
• You can have participants request the remote 


controls which you can allow or decline. 
• You can allow any participant to take over the 


mouse if they want to without your approval. 
You can temporarily take control of your mouse 
and keyboard back by clicking on the screen 
without revoking the access. That participant 
can click on the shared screen on his or her side 
to take control back. 
You as the host (or whoever is currently sharing 
their screen) can revoke the remote control 
from anybody at any time. 
The Remote Control feature is only available 
when Share Screen  is enabled. 
Remember, any participant who uses the Share 
Screen feature (if the host allows it), is in charge 


 of allowing and revoking Remote Control 
over their screen. 


 


Shared  
Screen
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Screen


Shared  
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Host picks Participants 


Here is the step-by-step procedure of an example, me as the host, giving control to Jim the participant: 


Allow Control: I as the Host,  on the Remote Control  button ➊ in the Meeting Controls to open the 
pop menu that lists all the participants (only the ones on computers, but not cell phone apps). I  on 
the participant (Jim) ➋ that I want to give control to. 
Host Waiting: The green Share Screen Strip on my (the host) side changes to reads "waiting for Jim to 
control your screen" ➌ 
Participant Ready: On Jim's side the green share strip changes from "You are viewing Edgar Rothermich's 
screen" ➍ to a yellow strip with the text "You can control Edgar Rothermich's screen" ➎. 
Waiting to Click: At the same time, a message pop's up on Jim's screen "Click to start the remote control of 
the shared screen" ➏. That means, Jim's control only starts once he clicked on the shared screen. 
Participant in Control: Once Jim clicks on the shared screen, then the shared screen is now controlled 
by Jim's mouse and keyboard. His yellow Share Screen Strip changes the text to "You are controlling Edgar 
Rothermich's screen" ➐. The green Share Screen Stri on my side, the host, changes to "Jim is controlling your 
screen" ➐. 
Attention Host: The host can still move the mouse over the shared screen but only the controlling 
participant's mouse will be displayed on the shared screen of other participants. If the host has the 
Zoom app in the foreground, then the controlling participant will move the mouse on the host 
computer. To avoid that, the host has to switch to any other app to be in the foreground. 
Toggle Control: If I  on the shared screen, the control goes back to me the host of the shared 
screen, but only as long as the controlling participant clicks the shared screen on his or her side again. 
This is a very useful situation to switch the control between host and participant back and forth. 
Revoke Control: I can terminated the control (by clicking the Abort Control ➒ on the Remote Control 
popup menu) or by the participant (by clicking on the View Options ➓ selector and selecting the red Stop 
Remote Control command). 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Participant requests Remote Control 


Any participant during a Zoom Meeting can make a request to control the shared screen. Here is that 
procedure: 


Host shares screen: Once the host shares his or her screen ➊, the green Share Screen Strip strip ➋ 
will be displayed on every participant's Meeting Window You are viewing NameOfHost's screen. 
Request Remote Control: Next to that green strip is the View Options selector ➌. A participant can  
on it and select from the menu Request Remote Control ➍. A dialog opens where the participant confirms 
that request by clicking the blue Request button ➎. 
Host Declines Request: A dialog will now pop up on the host computer with two options. Clicking 
the Decline button ➏ will pop up another dialog ➐ on the participant's computer that the request has 
been declined. 
Host Approves Request: If the host clicks the blue Approve button ➑, three things will happen 


On the host computer the share strip now displays "waiting for Jim to control your screen" ➒. 
On the participant computer who was approved for controlling the green share strip 
changes to the yellow strip with the text "You can control Edgar Rothermich's screen" ➓. 
Another message pops up on the participant computer Click to start the remote control of the 
shared screen. 


Participant takes over: Once the participant clicks on the shared screen, his or her mouse and 
keyboard now control that screen, until the host clicks on the screen or revokes the remote control. 


 


Remember, if a participant is sharing his or her screen, the that participant is in charge of the corresponding 
controls, indicated by the Remote Control button  that appears on their Meeting Controls. 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Participants are "auto-accepted" 


There is one more option that simplifies the remote control even further: 
Auto Accept: If you are in a Zoom Meeting as a host where you trust all participants to temporarily 
take over the mouse and keyboard of your shared screen, you can enable the option Auto accept all 
requests ➊. It is in the popup menu when you click on the Remote Control  button ➋ in the Window 
Controls. 
Request Remote Control: Now, when a participant clicks on the Request Remote Control ➌ option from 
the View Options ➍ popup menu, the request dialog ➎ also pops up. However, when clicking the blue 
Request button, the Share Screen Strip on the host ➏ and participant ➐ changes right away to indicate 
that the participant can take over the screen by clicking on it ➑.  


Meeting Menu 


Once a participant took over the shared screen via Remote Control, the host and the participant can end that 
status, as I pointed out earlier. However, there is one additional command: 
Whenever a participant is granted Remote Control, a new command Revoke/Give up Remote Control Permission is 
available in the Meeting Menu of the Zoom's main menu, on the host ➒ and the controlling participant ➓ side. 
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   File Exchange   


Chat Only 


The Chat Panel ➊ that is available during a Zoom Meeting is very versatile.  
You can send messages to everybody or to a specific participant by selecting the option from the To 
selector ➋. 
You can set up rules who the participants can send messages to.  the ... button ➌ on the lower-
right corner to open a menu ➍: 


• No One (Chat disabled for participants) 
• Send only to Host 
• Send to everybody 
• Send to everybody and to individual participants 


If a participant has the Chat Panel closed and, therefore, can't see the message, then the Chat ➎ 
button on the Meeting Controls turns orange ➎ with the number of unread chats (or downloads). A 
bubble ➏ with information about the sender and the message will pop up for a 10 seconds. This way 
you can read incoming messages without even opening the Chat Panel. 
Maybe remind the participants during a meeting to open the Chat Panel on their side so they can see 
the ongoing conversation.  


You can save ➐ the chat as text file that is stored in the Meeting folder on your hard drive. 
There are quite a few settings to configure various aspects of the Chat. Some settings are in the Web 
Portal and some in the Zoom Application. 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File Upload/Download 


In addition to sending text messages back and 
forth, you can also send files via the Chat Panel 
based on the same participant privileges set for 
sending messages. 


Enable ➊: File Transfer has to be enabled in 
the Web Portal Settings (sign in to your 
Zoom Account on the zoom.us website). 
Max File Size: You can send files with a file size up to 
512MB. 
File Types: It seems that Zoom supports many file 
types natively. Unsupported file types result in an error 
message ➋. However, you can always zip the file first. 
Upload: Files are uploaded to the Zoom server which takes a moment depending on the file size and 
your Internet upload speed. 
Download: An uploaded file appears in the participants Chat Panel and when clicked on it, it will be 
downloaded from the Zoom server to participant's hard drive. 
File Exchange: Everybody in the Meeting can 
send files back and forth based on the Chat Panels 
rules the host set up. 
All the files that were exchanged in the Meeting 
show up in the Chat Portal ➌ (based on sender/
recipient) and can be opened directly from there 
by clicking on it and even dragged from the Chat 
Panel directly onto the Finder. 


Web Portal Settings
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Upload Procedure 


In the Chat Panel, select from the To selector to whom ➊ 
you want to send the file to, everybody or a specific 
participant. 


 the File button ➋. 
A dialog opens that lets you navigate on your drive to the file 
that you want to upload. 


 the Open button in that dialog to start the upload 
procedure. 
The file appears in the Chat Panel ➌ with the file name, file 
type icon, file size, animated circular progress indicator, 
progress bar, and an x to stop the upload. 
If you click the x button during the upload, the upload will stop but 
stays in the Chat Panel, now showing an upward arrow badge ➍. 
You can  that badge to start the upload again. 
Once the upload is completed, a green 
checkmark badge ➎ appears next to the file 
type icon and a message ➏ that the file has 
been uploaded successfully. 
You can  on any file in the Chat Panel to 
open it. Or  on the ... button (that appears when you move the mouse cursor over it) to show its 
finder location. 


 


Download Procedure 


Once the upload of a file is complete on the sender side, 
the file will appear with a blue download badge ➐ in the 
Chat Panel of all the recipient(s). 
If the Chat Panel is not open, then a the Chat button on 
the Meeting Controls turns orange ➑ with a message 
bubble that someone who has sent you a file. 


 on the file in the Chat Panel to start the download 
which will download the file from the Zoom server to the 
local Download folder. 
During the download, the badge changes to the circular 
motion badge ➒ and the progress bar indicates the status. 
The x button lets you stop the download. 
Once the download is completed, the badge changes to a 
green checkmark ➓. 
You can now  on the file to open the file directly from 
there, or  on the ... button next to it with a command to 
"Show in Finder" ⓫. 


Be Aware: 
If someone sends a file to everybody, then that file will appear in the Chat Panel of every participant 
at that time. However, if someone joins the meeting after that, then the downloaded files will not 
appear in the Chat Panel of that participant. 
If a Participant leaves the meeting and joins back in, then their Chat Panel will be empty. Any file that 
he or she hasn't downloaded yet has to be sent (uploaded) again.  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 5 - Using the iPhone Live Cam 


One scenario in a class-related Zoom Meeting or collaboration could be that you want to demonstrate a 
specific application like Pro Tools, but have some hardware items that you also want to show and explain.  


For example: 
Microphones 
Hardware Mixer 
Control Surface 
Outboard Gear 
Audio Interfaces 
Music Keyboards 
Any other object 


Zoom has a built-in feature that lets you quickly use your iPhone or iPad to use as a handheld camera to feed 
that video signal to the ongoing Zoom Meeting so every meeting participant can see what you are pointing 
the camera at. 


Setup 


The integration of the iPhone Camera in Zoom is pretty simple. Instead of adding another feature, it is just 
another type of Screen Sharing. Instead of sharing the screen of your computer desktop, you share the 
screen of your iPhone or iPad. 


Step 1: Enable Screen Sharing 


The first step is to  on the green Share Screen button  ➊ on the Zoom Controls of your Meeting Window 
which opens the Share Screen Setup Window where you can select the various options what to share. 
 


➊
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Step 2: Enable iPhone/iPad via AirPlay 


On the Share Screen Setup Window (under the Basic tab ➊), you should see the third tile labeled 
"iPhone/iPad via AirPlay" ➋. This uses Apple's AirPlay technology, a wireless ad-hoc network without 
any configuration (maybe a password). Devices, in this case your computer and your iPhone or 
iPad, discover each other and you just select the corresponding device to broadcast video and 
audio wirelessly. 


To establish the connection, select the iPhone/iPad via AirPlay tile ➋ and then  the Share button ➌ (or 
just  the tile). 


The computer screen turns gray with instructions ➍ what to do next on your iPhone or iPad to 
establish the connection. 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Step 3: Enable iPhone 


The next steps have to be done on the iPhone or iPad to establish the connection with Zoom on your 
computer. 


Swipe up or down (depending on your device) to show the Control Panel ➊. 
Tap on the Screen Mirroring button ➋ 
The next window opens ➌ showing you all the detected devices around you that you can connect to 
via AirPlay. It should show the name "Zoom-"YourComputerName". In my case it is Zoom-iMac 5k ➍. 
Tap on this button and the screen returns to the Control Panel ➎. Now it has the Screen Mirroring 
button selected ➏ (highlighted) showing the name of the Device your iPhone or iPad is connected to 
via AirPlay in my case Zoom-iMac 5k. 
Now you should see also the iPhone or iPad screen on your computer screen with a green frame 
around it. 


 


What do you see? 


While in this AirPlay Screen Sharing Mode you can move that iOS screen around on your computer desktop 
and also view other applications. The window will automatically change from portrait to landscape mode 
depending on how you hold your iOS device and if it changes orientation. 


What do the Zoom participants see? 


The Zoom participants only see the content of the iOS window, the window on your screen with the green 
frame around it. They will not see any other windows that you have open on your desktop, similar to when 
you select a specific window instead of your desktop for Screen Sharing. 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Step 4: Camera App 


Once your iOS device is connect via AirPlay, you can use it in two ways: 
 


Onscreen Demonstration: You can show any iOS app (and how to use it) on your iOS device, 
because what's on your iOS screen is shared 
to your Zoom participants via Screen Share. 
Camera Mode: If you turn on the Camera 
app ➊ and set it to Photo or Video, your iOS  
works as a live camera that you can point at 
objects to show to the meeting participants. 
However, it shows all the onscreen camera 
controls ➋ and the meeting participants also 
see that. You can't hide those controls, but 
you can use third-party apps that allow you 
to do that. 


 


Step 4: Third-Party Camera App 


There are third-party camera apps available that let use you iOS device as a live camera. I use 
the app CameraVision, 99c on the App Store. 
https://apps.apple.com/us/app/cameravision/id412366083 


This simple app has all the basic features you need for live broadcasting: 


Tap on the screen to toggle the onscreen controls on ➌ or off ➍. 
Switch between front and rear camera. 
It automatically rotates the orientation or you can lock it. 
Tap the Pause button for freeze frame, so you can put the iOS device at the side if you want to 
elaborate on an image. 
Pinch to zoom in/out. 
Slide to show a red onscreen arrow for pointing at things on screen. 
Turn the iPhone Flash on/off 
Toggle the camera on/off 
Enable the microphone (it seems that the audio is only transmitted to the computer speaker but not 
to the Zoom participants). 


iOS Camera App
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➋


iOS app "CameraVision" iOS app "CameraVision" (hidden controls)
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 6 - Advanced Audio Routing   


   Pro Tools   


If you have a Pro Tools Session or any other DAW project that has a different Sample Rate than 48kHz and you 
want to play it in a Zoom Meeting, then you cannot use the Computer Sound Mode with the 
ZoomAudioDevice that only works in 48kHz. 
The following signal flow diagram shows an example that demonstrates some advanced signal routing using 
"Soundflower" that enables you to use those non-48kHz sessions in your Zoom meeting. 
I will explain the details step-by-step on the next few pages. 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Soundflower - virtual audio busses 


The first component you need for this special routing is Soundflower, a third-party software that creates 
virtual audio busses in macOS that function similar to Internal Aux Busses on audio mixing consoles and 
DAWs. This is a free software similar to other commercial software solutions like Loopback from Rogue 
Amoeba. 


Step 1: Download/Install 


Here is a download link to get Soundflower 2.0b2 
https://github.com/mattingalls/Soundflower/releases/tag/2.0b2 


Once you installed it successfully, you should see two new Audio Devices in the 
Output Device section ➊ and the Input Device section ➋ on macOS: 


Soundflower (2ch) 
Soundflower (64ch) 


Step 2: Create Aggregate Device 


Now you have to create a new Aggregate Device in the Audio MIDI Setup utility: 
Open AMS: Launch the utility app Audio MIDI Setup (located in the Utilities 
folder inside the Applications folder) and open its Audio Devices Window ➌ 
(key command  ). 
Create a new Aggregate Device:  on the plus button ➍ in the lower 
left corner and select Create Aggregate Device ➎. It will be added to the Sidebar. 
Name it:  the new Aggregate Device and name it "Aggregate - Zoom" ➏. 
Configure Aggregate Device: Once selected, you will see on the right side all the available Audio 
Devices ➐ available on your computer, each with a checkbox Use ➑ to choose which Audio Device to 
include in that Aggregate 
Device. 


The order you select the individual 
Audio Devices is important. The 
first device you select (enable Use checkbox) will move to the top of the list, the second item you select 
moves to the second position and so on. The order of the selected items is important because that 
determines how they show up in the I/O Setup Dialog of your DAW with generic names Output1-2, Output 3-4, 
etc. so you have to remember the position of those multiple channels. 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Step 3: Configure Aggregate Device 


Here is the configuration of the Aggregate Device based on my setup. If you use different microphones, 
speakers, or use a different interfaces, you have to change the configuration accordingly. However, make sure 
you follow the rules on how to setup the Aggregate Device. 


Built-in Microphone ➊: The Built-in Microphone device is the first device on the list. One important 
aspect of the Aggregate Device is that one of the included devices has to provide the Word Clock. 
You determine that with the Clock Source selector ➋ on top of the window. With the Sample Rate selector 
➌ below, you set the Sample Rate for the Device and, therefore, for the entire Aggregate Device. 
AirPods ➍: I use the AirPods as my headphones so I'm not tied to the desk during the meeting with a 
headphone cable and also avoid any crosstalk if I would use speakers. If you want to use headphones 
connected to your computer, just select the Built-in Output instead. 


Attention: In my tests, using AirPods as Clock Master defaults to 16kHz. Also, adding the AirPods 
Input Device removes one channel of the stereo AirPods output Device. Must be a bug. 


Soundflower (2ch) ➎: I use this virtual stereo bus to route the audio signal from the DAW to the 
Zoom "mic"  input. Will explain later. 
Soundflower (64) ➏: This is the virtual bus that I set my System Audio to. This way I can use that 
Device as the input on one of my Pro Tools Tracks to route audio of all applications (QuickTime, 
Safari, iTunes, etc.) to one Audio Track of my Pro Tools Session. Will explain later. 


Master Word Clock 


When you  on the disclosure triangle ➐ next to the Aggregate Device in the sidebar, you can see all the 
Devices "included" (combined) in that Aggregate Device, plus the icon ➑ that indicates which Device 
functions as the Master Clock  and which one follows as the Slave .  


Soundcloud 64 channels 


A note about the "Soundcloud (64ch)" Device. Although this device provides 64 internal audio busses 
(channels), I use only the first two. Any non-DAW application (i.e. Safari, iTunes) that cannot select a specific 
channel will default to using the first two channels. That's how I use it. 
The reason why the Soundcloud (64) has to be placed after "Soundcloud (2ch)" is that the I/O setting is easier 
to configure as you will see on the next page. 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Step 4: Select Playback Engine 


The configuration in Pro Tools starts with the  Playback Engine 
Launch Pro Tools 
Make sure that no Session is open 
Open the Playback Engine Dialog from the Main Menu ➤ 
Setup ➤ Playback Engine... 


 the Playback Engine selector and select the "Aggregate - Zoom" ➊ Device that we created in the 
previous steps. 


Step 5: Configure Pro Tools I/O Setup 


Configuring the I/O Setup Dialog (Main Menu ➤ Setup ➤ I/O...) in Pro Tools is crucial before you open or 
create a Pro Tools Session.  
Usually, when you choose a specific Audio Device, you know the channel configuration and, most likely, the 
device is passing the channel names on to Pro Tools so the corresponding Input Paths 
and Output Paths in the I/O Setup Dialog are already properly labeled. However, 
when selecting an Aggregate Device as the Playback Engine that contains a lot of 
individual devices, then the I/O Setup can look really messy. 
Make sure to delete the current Input Paths and Output Paths and click on the Default 
button ➋ so Pro Tools shows all the available input and output channels for the 
selected Aggregate Device. 


Input Paths 


Now you can see the reason why it is important to have a specific order of the individual devices "inside" an 
Aggregate Device. If the I/O Setup Dialog only shows you In 1-2, In 3-4, In 5-6, then you have no idea what 
device/channel they represent.  
The best way is to have the Audio MIDI Setup window open ➌, showing the Audio Devices of the Aggregate 
Device you are using and match the order and the amount of audio channels in the I/O Setup Dialog ➍. 
A few explanations: 


Remember that you can name the Input Path (  on it) whatever you want and even  them 
up/down to change the order on the list (I recommend that after you identified the channels and 
named them properly). 
You can see on the third item Sunflower 64ch (from SysAudio) ➎, that I included some "hints" in the name. 
This makes it easier when you do the routing later in your Pro Tools Session so you not only know 
what channel this is (Sunflower 64ch), but also the purposes for what you use that channel for (System 
Audio is routed to that bus). 
The Input Paths In 7-8, In 9-10, etc. are the rest of the 64 channels of the Sunflower (64ch) Device. 
Because I don't use those channels I don't bother to label them. 
For our purpose, we won't need the Input Path Sunflower 2ch, but I labeled it anyways.  


 


Pro Tools: Playback Engined Dialog


➊


I/O Setup Dialog


➋


Audio MIDI Setup


Pro Tools: I/O Setup Dialog


➌ ➍


➎➏


➐
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Output Paths 


Labeling the Output Paths is similar. Put the Audio MIDI Setup ➊ next to it to identify the individual channels 
and name them accordingly. In our setup we will need only the first two outputs "🔈  AirPods" and "🔈  Sunflower 
2ch (Zoom)".  
BTW, I like to use special characters (∑, ¶) and emojis (🎤  🔈  🎹  🎸 ) when naming things (Tracks, Paths, 
Busses, etc.). This helps to identify items and their purpose very quickly. 
 


Bus Paths 


Here is the preparation for the Bus Paths: 
Create one stereo Bus Path (named "To AirPods") ➋ to function as the Output Bus Path, mapped to the 
Output Path "🔈  AirPods" ➌. 
Create another stereo Bus Path (named "To Zoom") ➍ to function as the Output Bus Path, mapped to 
the Output Path "🔈  Sunflower 2ch (Zoom)" ➎.

Create one stereo Bus Path (named "Sub ∑") ➏ to function as the Internal Bus Path. That is the 
important bus used for the Sub Master Track. 
The other two busses labeled with a dot (.) and a double dot (..) ➐ is something that I have in all my 
Pro Tools Sessions. I assign those "dummy" input busses to any Track without an input, so the Mixer 
Window looks less busy and I can focus on Tracks that have an actual input assignment. This helps to 
better follow signal routing in a Session. 


Audio MIDI Setup


Pro Tools: I/O Setup Dialog


➊


Pro Tools: I/O Setup Dialog


➎


➋ ➌
➍


➏ ➐
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Step 6: Mixer Window Configuration 


In this step I explain how to create the essential Tracks and how to configure the routing.  
In this example I only have three Tracks ➊ to simulate the session. The other Tracks are for essential routing 
that I explain on the next few pages. If you have an existing Pro Tools Session, you have to modify the routing 
accordingly to establish this functionality. 


Two Master Fader Tracks 


You have to have two Master Fader Tracks: 
• 🔈  AirPods ➋: This is the master for the Output Bus Path "To AirPods" ➌ mapped to the Output Path "🔈  


AirPods" ➍ which represent your AirPods ➎. This Track controls the signal that is going to your AirPods, or 
whatever device you use as your own monitoring destination. 


• 🔈  Zoom ➏: This is the master for the Output Bus Path "To Zoom" ➐ mapped to the Output Path  
"🔈  Sunflower 2ch (Zoom)" ➑. It represents the Sunflower (2ch) Audio Device (routed to Zoom ➒) that we 
will select as the Microphone Input ➓ in the Zoom application. That means any signal in Pro Tools 
routed to this Track will go to the participants of your meeting. 


 


Zoom Application


You can hear it
Zoom Participants 
can hear it


➋


➌


➍


➎


➏
➊


➐


➑


➒


➓


Pro Tools: I/O Setup Dialog
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Aux Input Track (Sub ∑) 


As with any Pro Tools Mix Session, you don't route your individual tracks directly to the Output Bus Path, 
instead, you create a dedicated Aux Input Track that functions as a Sub Master were all tracks are routed to 
via an Internal Bus Path, and only that Sub ∑ has its output routed to the actual Output Bus Path, represented 
by the corresponding Master Fader Track. 
So we have three steps: 


Create Sub ∑ Track: Create a new stereo Aux Input Track (if it doesn't exist yet in 
your Session) and name it "Sub ∑" ➊ or whatever naming convention you use. 
Select Input Path:   on its Input Path Selector and choose the Internal Bus 
Path "Sub ∑" ➋ that we created earlier in the I/O Setup Dialog. This is the Internal 
Bus Path (almost) all the Tracks in your session will be routed to. 
Select Output Path: The output configuration is a little bit different: 
• We have two Master Fader Tracks representing the two final output 


destinations, your AirPods ➌ and the Zoom ➍ participants in your meeting 
and our Sub ∑ Track has to route its output to both of these destinations. 


• Pro Tools has the functionality to route the output of a Track to multiple Output 
Bus Paths.   on the Output Path Selector ➎ to select the first output "To AirPods" ➏ and then    
on the Output Path Selector ➎ again and when the menu opens, now   on the second output 
"To Zoom" ➐ on the menu and that output will be added. 


• The Output Selector shows a plus sign ➑ to indicate that the Track is routed to multiple outputs. 
• When you  on the Output Selector, you will see all the currently selected outputs on the menu 


withe a checkmark.   on a selected output if you need to deselect one. 
Solo Safe:   on the Solo Button  ➒ to solo-safe that Track. 


➊


➌ ➍


➎


➒


➏


➐


➑


➒
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Audio Track (System Input) 


Because we are not using the standard Zoom routing that sends our Mic signal and the output of the audio 
applications (System Audio) to the Zoom meeting, we have to route these two audio sources through our Pro 
Tools Session.  
First, the System Audio Track that will receive all the audio signals from the apps on our computer that are 
routed to the System Audio. 


Create a new Audio Track and name it "SystAudio" ➊. 
On the Input Path Menu  on the interface item ➋ and select Sunflower 64ch (from SysAudio) ➌ from 
the submenu. Any audio signal routed to the Soundflower (64) device will "arrive" at this Channel 
Strip. 
On your computer desktop  on the speaker icon  ➍ in menu bar to open the list with the 
available Output Devices. This selection determines the System Audio which means to what 
audio device are the audio outputs from all applications routed to. By selecting Sunflower 64ch (from 
SysAudio)  ➎ you route those signals to the first two channels of the Soundflower (64ch) device, 
which will "arrive" at our SystAudio Track ➏. 
From the Output Path Selector choose the Internal Bus Path Sub ∑ ➐. This routes the System Audio 
to the Sub ∑ Track ➑ which routes the signal to both outputs ➒, the AirPods (so you can hear it) 
and Zoom (so the Zoom participants can hear it). 


  on the Solo Button  ➓ to solo-safe that Track. 
Important: Enable the Input Monitoring Button  ⓫�to have that track "live" (pass through). 
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Audio Track (Mic Input) 


Here are the steps to create the second Audio Track, the Mic Input. Remember, we 
are using the Soundflower (2ch) audio device as the Microphone Input on the 
Zoom application ➊ which means we cannot feed our mic directly to the Zoom 
application and, instead, use a "live" channel on our Pro Tools Session for our Mic 
signal.  


Create a new Audio Track and name it "Mic" ➋. 
On the Input Path Menu  on the interface ➌ item and select Built-in 
Microphone ➍ from the submenu to route the microphone to that channel Strip.  
On the Output Path Menu  on output ➎ and select the Output Bus Path To 
Zoom ➏. Please note that this is a routing exception because this is a Track that 
we route directly to the Master Fader Track ➐ and not the Sub ∑. The reason 
for that is that we don't need to hear ourself in our own headphones. 


  on the Solo Button  ➑ to solo-safe that Track 
Enable the Input Monitoring Button  ➒ to have that track "live" (pass through). 


Other Tracks 


Other Tracks that you create (or already exist) in the Session have to be routed to the Sub ∑ Track via the Sub ∑ 
bus ➓ so they are sent to your headphones and to the Zoom participants in your meeting. 


Zoom Application
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Step 7: All together now 


Here is a summary of all the components in your Mixer: 
Mic Track ➊: Having your mic routed through Pro Tools gives you much greater control over that 
signal. Adjust the level with the Volume Fader, use the Mute Button , add compressor to the mic, 
EQ your mic signal, add Reverb or other effects (why not?) Remember that this Channel is routed 
directly ➋ to Zoom ➌, so you can't hear the output. However, just change the output routing 
temporarily and you can monitor your own signal. 
SystAudio ➍: You have the same control over the System Audio, the signals that come from all the 
apps on your computer like YouTube, iTunes, Spotify, QuickTime, etc. 
Sub ∑ ➏: The Sub ∑ Track controls the signal to both outputs. Its mute button is a quick way to cut all 
audio from Pro Tools except your mic (which goes directly to the output ➋). 
AirPods and Zoom Master Track: You can control the signal that goes to your headphones ➐ and to 
Zoom ➌ independently. Maybe put a limiter on those tracks. A Dither Plugin might be overkill. 
Zoom Controls: The Speaker icon ➑ on the Zoom application still works. However, instead of only 
muting your microphone, it mutes the entire signal coming from Pro Tools via the Soundflower (2ch) 
bus ➒. 
AirPods: Pay attention to the AirPods because they receive two signals. One is coming from  Pro 
Tools ➐ via one of its output busses and the other one is the return signal from the Zoom participants 
➓. Make sure to have AirPods (or whatever you use as your monitor) selected in the Zoom application 
under the Select a Speaker menu ⓫.  


Zoom ParticipantsYour headphone


to


from
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➍
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And here is the signal flow diagram again to show the routing that we achieved with the Pro Tools and Zoom 
configuration on the previous pages. 
 


Safari 
(YouTube)


iTunes


QuickTime


Pro Tools


Playback Engine


System Audio


Soundflower 2ch


AirPods


Aggregate: 
>AirPod 


>Soundflower 2ch


Soundflower 64ch


Aggregate: 
Soundflower 64 > 


Mic >
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   Logic Pro X   


Here are the instruction if you want to play a Logic Project in your Zoom Meeting. The concept is the same as 
with Pro Tools but the routing is a little bit different based on the different architecture of both DAWs. 


Step 1-3 Install SoundFlower and Configure AMS 


Step 1-3 are the same. If you haven't done so, you have to download/install Soundflower and configure the 
Aggregate Device "Aggregate - Zoom" in the Audio MIDI Setup. 


Safari 
(YouTube)


iTunes


QuickTime


Logic Pro X


Audio Preferences


System Audio


Soundflower 2ch


AirPods


Aggregate: 
>AirPod 


>Soundflower 2ch


Soundflower 64ch


Aggregate: 
Soundflower 64 > 


Mic >
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Step 4: Select Playback Engine 


Go to the Preferences ➤ Audio ➤ Devices and 
choose Aggregate - Zoom ➊ from the Output Device 
selector and Input Device selector. 


Step 5: Configure Pro Tools I/O Setup 


Open the I/O Labels Window ➋ from the main menu Mix ➤ I/O Labels...  
Remember, when creating an Aggregate Device that includes multiple Devices, the name of those Devices 
and their audio channels are not necessarily "known" to Logic and only show up as generic names In 1-2, In 
3-4, In 5-6. You have no idea what device/channel they represent when you select an Input or Output on a 
Channel Strip. The I/O Labels Window lets you name those audio channels. 


Input Labels 


The best way is to have the Audio MIDI Setup window open ➌, showing the Audio Devices of the Aggregate 
Device you are using and match the order and the amount of audio channels in the I/O Setup Window ➍. 


Output Labels 


Unfortunately, Logic won't allow to rename the Output 1-2 ➎ (it is grayed out) because it is not a specific 
output channel but a "placeholder". The actual output channel it represents is configured in the Preferences ➤ 
Audio ➤ I/O Assignments. 


Logic Pro X: Audio Preferences


➊


Audio MIDI Setup


Logic Pro X: I/O Labels Window➋


➌


➍


Audio MIDI Setup


Logic Pro X: I/O Labels Window


AirPods + Zoom ➎
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Step 6: Configuring "Output" 


This step is critical regarding the proper routing. Unfortunately, it is part of a more advanced 
feature in Logic that many users might not even be aware that it exists. I explain those routing 
mechanisms in my book "Logic Pro X - The Details", but here is the quick run 
through: 


The default output on the Channel Strips is Stereo Output ➊. 
When you  on that Output Selector ➊, you will see the available Output 
Channels ➋ of your selected Audio Interface (in this example, eight 
channels). 
However, the first menu option labeled Stereo Output is not necessarily Output 1-2 of your 
Audio Interface. Instead, this is an output that you can configure and it can be any of 
the available outputs on your Audio Device (similar to the concept of the Monitor Path 
in Pro Tools). 
When you go to the Logic Preferences ➤ Audio ➤ I/O Assignments ➌, you will see a 
section labeled Stereo ➌. The selector ➍ next to the label "Output" opens a popup menu 
with all the available output channels ➎ of your selected Audio Device. Whatever 
output channel you select here becomes the actual output channel any Channel Strip is 
routed to when you set that Channel Strip to "Stereo Out" ➊. Think of it as a placeholder, 
a Monitor Path. 
When the checkbox Mirroring ➏ is enabled, then the output signal of a Channel Strip that is set to 
Stereo Out is also routed to the Output Channel 1-2. This way the Channel Strip output is routed to 
two destinations. 
Usually, you don't even have to know about all this 
because, as a default, the Output selector in the this 
Preferences window is set to Output 1-2 (Stereo Output) ➍, 
the first two audio channels of your audio interface and 
the Mirroring checkbox is disabled in this case anyways. 
This (somewhat confusing) Logic implementation is a 
little bit weird but you have to wrap your head around it 
because we use that routing ability for our Zoom 
Meeting configuration. 


Output Routing 


Here is how we configure that Stereo section in the Preference Window. 
We set the Output selector to Output 3-4 (Sunflower 2ch ➤ Zoom) ➐. 


That means that all the Channel Strips that have their Output set to Stereo Out will send their signal to 
Output 3-4 of our Aggregate - Zoom device which represents the Sunflower 2ch Device that acts as an 
internal audio bus. On the Zoom Meeting Window we will set the input to exactly that Sunflower 2ch 
Device and, therefore, any signal sent to Stereo 
Out ➊ on the Logic Mixer will be routed to the 
Zoom Meeting input and, therefore, sent to the 
Zoom participants in that meeting ➑. 
We enable the Mirroring checkbox ➏. 


That means that all the Channel Strips that have 
their Output set to Stereo Out have their output 
also routed to Output 1-2 which represent the 
AirPods ➒ (the first two audio channels on our 
Aggregate Device), so we can hear the same 
signal that we send to the Zoom participants. 
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➋


➏
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➒


➌


➍


➎


Logic Pro X: Audio Preferences
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Step 7: Mixer Window Configuration 


In this step I explain how to create the essential Channel Strips we need for the Zoom Meeting and how to 
configure the routing in Logic Pro X.  
In this example I only have three Tracks (Drums, Bass, Guitars) to simulate the Project. The other Tracks are for 
essential routing that I explain on the next few pages. If you have an existing Logic Project, you have to 
modify the routing accordingly to establish this functionality. 


Input Routing 


First, we need two Channel Strips to feed our microphone and the System Audio to our Logic Project. 


Microphone Track 
You create an Audio Track ➊and from its Input 
Selector ➋, you chose Input 1-2 (Mic) ➌. That is the 
Internal Microphone ➍ that we configured in the 
Aggregate - Zoom device.  


• Solo-safe the Track  ➎. 
• Enable Input Monitoring  ➏ to make the 


Track "live". 


System Audio Track 
You create a second Audio Track ➐ and from its 
Input Selector ➑, you chose Input 5-6 (Sunflower 64ch - 
System Audio) ➒. We route the System Audio ➓ 
(Safari, iTunes, QuickTime, etc.) to that audio device 
(Sunflower 64) so we can tap it from that bus.  


• Solo-safe the Track . 
• Enable Input Monitoring  to make the Track 


"live" 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Output Routing 


Here is the reason why we need a special output routing with two destinations: 
AirPods and Zoom Participants: Whatever we play on our computer, the Logic Project ➊ and any 
audio from an app ➋ (i.e. YouTube video) needs to be routed to our AirPods ➌ (so we can hear it) and 
also to the Zoom participants ➍ (so they can hear it). 
Zoom Only: The exception is our microphone ➎. We only need to send that signal to the Zoom 
participants ➍ but we don't have to hear ourself in our own AirPods ➌. 


Here is how we create that special output routing: 
Mic: The first Channel Strip with the Mic input is the only Channel Strip that is routed directly to the 
Output 3-4 (Sunflower 2ch ➤ Zoom) ➏. Therefore, the mic ➎ is only sent to the meeting participants ➍. 
All Other Channel Strips: The second Channel Strip and all the other Channel Strip in your Project 
(except the Output Channel Strip and Master Channel Strip) are routed to Stereo Output ➑. 


Attention: 
Remember that "Stereo Output" ➑ is a placeholder. The actual output the signal on those Channel Strips 
is sent to depends on how we configured it in the Preferences. 


Output is defined as Output 3-4 (Sunflower 2ch ➤ Zoom ➒ and that is where those Channel Strips are 
routed to, to the participants ➍ in the meeting. 
The Mirroring checkbox ➓ is enables which means that 
all those Channel Strips are also routed to the Output 
1-2, the first two output channels of our Audio Device 
which represent the AirPods ➌. 


 


Stereo Out = Output 3+4 (Sunflower 2ch ➤ Zoom)


Output 1-2 = AirPods
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Step 8: All together now 


Here is a summary of all the components in your Mixer 


Mic Track ➊: Having your microphone 
routed through Logic gives you much 
greater control over that signal. Adjust the 
level with the Volume Fader, use the Mute 
Button , add compressor to the mic, EQ 
your mic signal, add Reverb or other effects 
(why not?). Remember that this Channel 
Strip is routed directly ➋ to Zoom ➌, so you 
can't hear the output yourself. However, just 
change the output routing temporarily and 
you can monitor your own mic signal. 
System Audio ➍: You have the same 
control over the System Audio, the signals 
that come from all the apps on your 
computer like YouTube, iTunes, Spotify, 
QuickTime, etc. 


AirPods and Zoom Track: You can control 
the Output Channel Strip of your mic signal 
➎ and the Output Channel Strip of all other 
Tracks ➏. Maybe put a limiter on. 
Zoom Controls: The Speaker icon ➐ on the 
Zoom application still works. However, 
instead of only muting your microphone, it 
mutes the entire signal coming from Logic 
➑ via the Soundflower (2ch) bus. 
AirPods: Pay attention to the AirPods 
because they receive two signals. One is 
coming from Logic ➒ via one of its output 
busses (Mirroring to Output 1-2) and the 
other one is the return signal from the 
Zoom participants ➓. Make sure to have 
AirPods (or whatever you use as your 
monitor) selected in the Zoom application 
under the Select a Speaker menu ⓫. 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Attention 


A Note about AirPods 


Although AirPods are very convenient, you have to keep an eye on them because they could mess up your 
routing. For example, if they disconnect (low battery, out of reach), they become inactive on the Aggregate 
Device and Pro Tools will throw a hissy fit. Also, if the AirPods come back online, they might automatically take 
over the System Audio and you have to set it back to Soundcloud (64ch). 
I also had some difficulty with Logic when having AirPods in the Aggregate Device, they were resetting the 
Sample Rate constantly to 48kHz. 


Sample Rate 


The Sample Rate is a very tricky subject in such a complex setup. Remember the important rules: 
When using an Audio Device only for your System Audio (Browser, QuickTime, iTunes, etc.) then you 
set the Sample Rate for those devices in the Audio MIDI Setup (AMS) utility. 
Some external Audio Interfaces set the Sample Rate on their device or their own software application. 
Most DAWs not only let you select the audio interface they are using, independently from the System 
Audio, they also let you choose the Sample Rate. In that case, they act as a remote control to 
CoreAudio and you can see the Sample Rate change in AMS, but you cannot control them anymore in 
the AMS. 
When you have two DAWs open at the same time (i.e. Logic Pro X and Pro Tools) then it gets messy. It 
depends who is "stronger" in trying to take control over the Sample Rate or who is crashing first. 
Sometimes AMS will crash ("Leave me out of that, I'm out of here"). 
When using an Aggregate Device, then the setup can gets even more unstable ... fun times. 


Here are few guidelines: 


Start with the Audio MIDI Setup utility first and set the Sample Rate that you want to use with Logic or 
Pro Tools. 
Launch the DAW without any session. Opening an existing session will change the Sample Rate on 
the AMS to that Sample Rate. 
On the DAW (no session open) select the same Sample Rate for the newly created session choosing 
the Sample Rate that you set in the AMS. 
Now the DAW and the AMS are in agreement about the Sample Rate (hopefully). 
If you have an existing Session that you want to use with that setup I just demonstrated, then make 
sure that the AMS is already set to that Sample Rate before opening the session. 
If you have one DAW with a session open and running properly with a specific Sample Rate, then you 
could open a second DAW as long a that session or project has the same Sample Rate. Otherwise, 
you will get error message, transposed audio, crashes, and other annoying stuff. 
Cross your finger and hope it works. 


Disclaimer 


For this examples I use macOS 10.14.6, Logic Pro X v10.4.8, Pro Tools v2019.12, and Zoom.us v4.6.8 
Functionality and stability might vary if you use other versions of those components. 


⚠
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7 - And There is More ... 


   What I didn't cover   


Although Zoom is very easy to use "on the surface" it is very powerful and sometimes complex once you dive 
deeper in to it. I covered some of those advanced topics in this book, however, there are much more features 
that I didn't get into because I wanted to concentrate more on the audio and collaboration aspect. 


Here are just a few topics you might further explore: 


Reactions ➊ 


You have two emojis that you can click to place in 
the upper-left corner of your video screen for 10 
seconds for everybody to see, for a quick thumb up 
or clapping reaction 


Virtual Backgrounds ➋ 


If your home office looks too messy, you can 
choose a virtual background (picture or video) to 
use as a background that works pretty good even 
without a screen screen. 


Record Meetings ➌ 


You can record your meeting, either to your 
computer or to the cloud (on the Zoom server). 
There are many options and configurations 
available for that in the Settings menus. 


Polling ➍ 


You can use the polling feature to actually create 
online quizzes 


Breakout Rooms ➎ 


You can split up a meeting into sub-meetings 


  


 


Don't forget the many hidden features 


When you move the mouse cursor over the video thumbnail of a participant,  on the  
button ➏ to open a menu with many options regarding the participants: 


Pin a Video to stay on as the Speaker Video. 
Spotlight a Video will pin that participant on everybody's Meeting Window. 
Make a participant a Host or Co-Host, basically give him host privileges. 
Allow a participant to record the meeting on their side 
Rename a participant to better keep track of the names 
Put a participant temporarily on hold so you can have a "private" conversation 
with the rest of the participants. 
Remove a participant, kick out of the meeting (make sure to disable "allow to 
rejoin" in the Web Portal Settings) 
Lock the meeting so no other participant join uninvited (you have to do that in the Participants Panel 
from the More menu at the lower-right corner. 


Settings 


Last but not least, go through the Settings in the Web Portal and the Zoom App to discover options that 
might be useful for you.  


➊


➋
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➏
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  Conclusion 


This concludes my manual “Zoom.us - How it Works, especially with DAWs and Audio Collaboration”. 


If you find my visual approach to explaining features and concepts helpful, please recommend my books to 
others or maybe write a review on Amazon or the iBooks Store. This will help me to continue this series.  
To check out other books in my "Graphically Enhanced Manuals" series, go to my website at: 
www.DingDingMusic.com/ 


 


To contact me directly, email me at GEM@DingDingMusic.com 






More information about my day job as a composer and links to my social network sites are on my website: 
www.DingDingMusic.com 






Listen to my music on SoundCloud  


Thanks for your interest and your support, 


Edgar Rothermich


Upcoming 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